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1 | Welcome 

Congratulations on purchasing the Hewlett-Packard Jornada 560 series 
personal digital assistant powered by Microsoft® Windows® for Pocket 
PC. Your hp Jornada lets you keep your most important business and 
personal information current and close at hand. Your hp Jornada includes 
Microsoft Pocket PC Software 2002, which includes the latest version of 
Microsoft Pocket Outlook®, so you can read and write e-mail while on the 
road and manage your appointments and contacts. You will find that your 
hp Jornada is also the perfect companion to your desktop or notebook PC, 
allowing you to take vital business data and documents with you and 
easily upload updated information upon returning to your desk. The hp 
Jornada offers you the highest quality in performance and power 
management as well as rich programs and utilities designed by Hewlett-
Packard, making hp Jornada your powerful, reliable, mobile business 
partner. 

In this chapter, you will find: 

• a list of the hp Jornada package contents. 
• an overview of this User’s Guide, and pointers to other sources of 

helpful information. 
• descriptions of the programs and features included with your hp 

Jornada. 
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What’s in the Box 
Your hp Jornada package includes the following items:  

• hp Jornada 560 series personal digital assistant 
• hp Jornada main battery (rechargeable lithium-polymer battery pack) 
• 3-volt CR-2032 coin cell backup battery (attached to the Quick Start 

Card)  
• ac adapter  
• USB cradle for connecting your hp Jornada to your desktop PC 
• hp Jornada Quick Start Guide—a graphic guide to setting up your hp 

Jornada 
• hp documentation pack—includes this User's Guide and Regulatory 

Information Leaflet, and the hp Jornada Accessory Guide 
• Pocket PC Companion CD—includes Microsoft ActiveSync® and 

Microsoft Outlook 2002 for your desktop PC, as well as programs 
and utilities that add functionality to your hp Jornada  

 
 

Using This Manual 
This User's Guide is designed to help you get started using your hp 
Jornada quickly and easily. Although great care has been taken to ensure 
the accuracy of procedures and artwork, some of the screens displayed on 
your hp Jornada may be different from the ones that appear in this User’s 
Guide.  

Detailed, step-by-step instructions for using the programs on your hp 
Jornada are also included in online Help, so you will always have access 
to them, and you do not have to carry this guide when you travel. (For 
more information on using online Help, see “Using Online Help on Your 
hp Jornada,” later in this chapter.) 
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This User's Guide includes certain visual cues that will help you find the 
information you want easily.  

A shortcut, another way to do something, or expanded information 
about the topic. 

Caution or warning information about the topic. This is important 
information that should be observed to prevent loss of data or 
damage to your hp Jornada. 

Helpful information related to the topic. 

 

hp Jornada Programs 
Your hp Jornada already includes the full suite of software you need to 
function as a mobile professional. These programs are introduced below. 
Detailed information can be found in later chapters.  
 

 
The programs listed below are preinstalled in Flash ROM or in the hp safe store 
folder. These preinstalled programs will not be deleted if your hp Jornada suffers
a loss of power.  

 

hp Programs 
hp backup. Protect your valuable data even when you are away from 
your office by backing up your personal information manager (PIM) 
databases (Contacts, Calendar, and Tasks) or your entire hp Jornada to 
the hp safe store folder or to an optional CompactFlash card. 

 

hp emergency backup. Automatically back up your PIM databases 
to the hp safe store folder, so they are protected even when you restore 
your hp Jornada to its factory default settings.  
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hp home menu. Quickly launch your favorite programs or open 
frequently used documents. Assign each of the buttons on the hp home 
menu to a different document or program. 

 

hp task switcher. Switch between open programs and documents, or 
close any program from a pop-up menu. 

 

hp image viewer. View individual images or run a slideshow on the 
screen of your hp Jornada.  

 

hp pocket camera software. Use the optional hp pocket camera to 
snap pictures with your hp Jornada.1     

 

hp Microchai. The micro edition of hp ChaiVM—a Java™ application 
environment for intelligent appliances—hp Microchai enables you to 
download Java applications on demand to your hp Jornada.  

 

hp settings. Adjust the brightness of the display, set power preferences, 
and set the speaker volume to suit your work environment. Choose from 
the preset profiles or create your own. 

 

hp display profile. Quickly switch among preset or user-defined 
profiles for screen brightness and backlight settings.  

 

hp volume profile. Quickly switch among preset or user-defined 
profiles for speaker volume, alerts, and reminders.  

 

hp quick menu. Use a pop-up menu to open the Align Screen control 
panel or turn the display off.  

 

 

1 Requires the optional hp pocket camera. For more information, see the hp 
Jornada Accessory Guide. 
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Microsoft Pocket PC Software 
 ActiveSync. Synchronize information between your device and desktop 

computer.  

 Calendar. Keep track of your appointments and create meeting 
requests. 

 Contacts. Keep track of your friends and colleagues. 

 Inbox. Send and receive e-mail messages from your hp Jornada. 

 Notes. Create handwritten or typed notes, drawings, and recordings. 

 Pocket Excel. Create new workbooks or view and edit Excel 
workbooks created on your desktop PC. 

 Pocket Word. Create new documents or view and edit Word 
documents created on your desktop PC. 

 Tasks. Keep track of your to-do list. 

 Microsoft Pocket Internet Explorer.1 Browse the Web and view 
channels and subscription content. 

MSN Messenger.1 Send and receive instant messages with your 
MSN® Messenger contacts. 

 Microsoft Windows Media Player for Pocket PC.2 Play audio 
and video clips on your hp Jornada. Windows Media™ Player lets you 
play songs and video files that have been recorded in the MP3 or WMA 
formats. 

 Microsoft Reader. Read electronic books on your hp Jornada. 
 

1 Requires an optional modem and an account with an Internet service provider. 
2 Check the Microsoft Mobile Devices Web site for updates to Windows Media 
Player, including details on support for video file formats and streaming audio and 
video capabilities. 
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Third-Party Software 
OmniSolve business calculator. Perform complex mathematical 
and business calculations with this full-featured calculator from Landware.

 

Developer One CodeWallet Pro. 1 Store, organize, and retrieve 
personal information, such as passwords, credit card numbers, favorite 
URLs, and emergency phone numbers. 

 

Stowaway Portable Keyboard driver. Preinstalled driver for a 
folding, full-size keyboard from Targus. 

 

AccessPanel Platinum.1 Speed your data entry by pasting common 
phrases, contact information, or date and time stamps into any 
application with a few screen taps. 

 

 

Additional Programs  
The Pocket PC Companion CD included with your hp Jornada has 
additional programs for both your desktop PC and your hp Jornada.  
 

 
You can also install programs from a variety of sources, including the Internet. 
For more information, see “Adding or Removing Programs,” in chapter 6.  

 

Programs for your hp Jornada include  

• AudiblePlayer™ 2.0 and AudibleManager 3.0 from 
Audible Inc. Listen to best-selling audiobooks, newspapers, 
magazines and more! 

• HPC Notes Lite Edition, and a trial version of HPC Notes 
Professional from PhatWare Corporation. HPC Notes 4.0 Lite Edition 
is a powerful notes creator and organizer for Windows Powered 
Pocket PCs. It allows users to create notes, password-protect them, and 
organize them by type, subject, creation and modification date. 

 

1 May not be available on some hp Jornada 560 series models. 
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Programs for your desktop PC include 

• Microsoft ActiveSync 3.5. Synchronize your hp Jornada with your 
desktop PC.  

• Microsoft Outlook 2002. Manage your messages, appointments, 
contacts, and tasks on your desktop PC. 

• MusicMatch® JukeBox 6.0 from MusicMatch Corporation. 
The award-winning MusicMatch Jukebox lets you record, download, 
stream, organize, and play digital audio and video on your desktop 
PC, and format music into MP3 or WMA to play on your hp Jornada.  

• Developer One documentation. In-depth documentation for 
CodeWallet and AccessPanel Platinum.  

 

 
The programs included on the CD are subject to change. Check your CD for the 
complete list, and visit the hp Web site at www.hp.com/jornada for even more 
programs and software updates.  

 

Where to Find Information 
The following table is a guide to additional information to help you use 
your hp Jornada.  
 
For information on See this source 

Programs on your hp Jornada This User’s Guide or online Help. Tap 
Help on the Start menu to view 
Help. 

Additional programs that can 
be installed on your hp 
Jornada 

The Pocket PC Companion CD and the 
hp Web site at 
www.hp.com/jornada. 

Connecting to and synchro-
nizing with a desktop PC 

ActiveSync Help on your desktop PC.  
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For information on See this source 

Last-minute updates and 
detailed technical information 

The Read Me files in the Microsoft 
ActiveSync folder on your desktop 
PC or the Pocket PC Companion CD, 
and the hp Jornada Web site at 
www.hp.com/jornada. 

Troubleshooting connections 

 

The ActiveSync Troubleshooter on your 
desktop PC. On the ActiveSync File 
menu, click Connection Settings, 
and then click Help.  

The latest on Windows 
Powered Pocket PCs  

The Microsoft Mobile Devices Web 
site: 
www.microsoft.com/mobile/pocketpc 

 

 

 

The complete text of this User's Guide is also available on the hp Web site at 
www.hp.com/jornada. You can download the User's Guide to your desktop PC 
and view it using the Adobe® Acrobat® Reader, available from the Adobe 
Web site at www.adobe.com. 

 

 

Using Online Help on Your hp Jornada 
You can get help for specific programs and for Microsoft Pocket PC 
software by tapping Help on the Start menu. Help is displayed for the 
active program. To display a menu of all Help files available on your hp 
Jornada, tap the View menu, and then tap All Installed Help, or simply 
tap Help while the Today screen is active.  

Navigate in Help just as you navigate in Microsoft Internet Explorer: by 
tapping links or tapping the  button. When you have finished viewing 
Help, tap  to return to the program you were using. 
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2 | Getting Started 

This chapter will help you start using your hp Jornada. You will become 
familiar with the hardware and learn how to set up your hp Jornada. 
When you finish this chapter, you will have all the information you need to 
begin working with your hp Jornada.  

This chapter includes step-by-step instructions to help you 

• Identify hardware features. 
• Install the batteries. 
• Power up the first time. 
• Complete the Welcome Wizard. 
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Hardware Features 
The illustrations below introduce you to the various buttons, connectors, 
ports, and other features of your hp Jornada. 
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1. Up/down control. Scroll through 
documents. 

2. Record button. Press and hold to 
record voice notes. 

3. Backup battery slot. Remove the tray 
to install or replace the backup 
battery. 

4. Navigation pad. Press to navigate 
through documents or select on-screen 
buttons and controls. 

5. Backup battery lock. Slide and hold 
to remove the backup battery tray. 

6. Notification button/LED. Notifies you 
of scheduled appointments, alarms, 
and reminders. The LED indicates 
power status while recharging. 

7. Ambient light sensor. Automatically 
turns on the backlight.  

8. Touch screen. Tap on-screen controls 
or buttons to select menu commands 
or input text. 

9. hp hot keys. Press to open an 
application or programmed function. 

10. Speaker. Listen to music or set 
audible reminders and alerts. 

11. DC jack. Connect to ac power to 
recharge your main battery. 

12. Action button. Click to open the 
selected item. 

13. USB/serial port. Connect to your 
desktop PC using the supplied cradle, 
or an optional sync cable. 

14. Power button. Press to turn on your hp 
Jornada. Press and hold to turn the 
backlight on or off. 

15. Microphone. Speak into the 
microphone to record voice notes. 
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16. Main battery. Recharge the lithium-
polymer main battery by 
connecting to ac power. 

17. Reset button. Use the stylus to 
press the reset button and restart 
your hp Jornada. 

18. Main battery lock. Slide to enable 
removal of the main battery pack. 

19. Stylus. Use the stylus to navigate 
on the hp Jornada touch screen. 
Store it in the stylus slot when not 
in use. 

20. CompactFlash Type I extended 
card slot. Add functionality with 
optional CompactFlash Type I or 
Type I extended cards. 

21. Infrared port. Beam files to other 
mobile devices. 

22. Stereo headphone jack. Connect 
a pair of stereo headphones. 
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Using Your hp Jornada for the First Time 
 

Follow these steps to begin using your hp Jornada: 

1. Install the main battery. Align the main battery with the slots 
on the back of your hp Jornada, and slide until it locks in place.  

 

2. Install the backup battery. The CR-2032 coin-cell backup 
battery is attached to the Quick Start Card. Use the stylus to hold 
the backup battery lock in the OPEN position, and remove the 
backup battery tray. Place the backup battery in the tray with the 
+ sign facing up. Slide the tray into its slot until it locks into place.  
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3. Connect to ac power. Assemble the ac adapter, and connect 
it to the dc jack on your hp Jornada. Do not disconnect your hp 
Jornada from ac power until the green LED indicates that the main 
battery is fully charged.  

 

4. Follow the Welcome Wizard. The first time you start your hp 
Jornada, the Hewlett-Packard Welcome screen appears. Then, 
after a few moments, the Welcome Wizard begins. The Welcome 
Wizard presents a brief orientation to Microsoft Windows for 
Pocket PC, helps you align the touch screen, and prompts you to 
select your city and time zone.  
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Powering Your hp Jornada  
Because the data and files you save on your hp Jornada are stored in 
RAM, maintaining a continuous power supply to the hp Jornada at all 
times is extremely important. If your hp Jornada runs out of power, all 
information stored in RAM is lost. The preinstalled programs will not be 
deleted even if your hp Jornada suffers a loss of power; however, any 
custom settings and programs you have added will be erased. 
  

 

To safeguard data against loss in the event of power failure, you can save or 
back up files to the hp safe store folder. The hp emergency backup application 
automatically saves your PIM databases to the hp safe store folder. For more 
information, see “Backing Up and Restoring Data” and “Managing Memory” in 
chapter 6. 

 

 
Your hp Jornada receives power from three sources: the main battery, the 
backup battery, and the ac power adapter. The following sections 
describe these sources. For tips on extending battery life, see “Managing 
Power” in chapter 6. 

Main Battery 
The hp Jornada lithium-polymer battery pack (the main battery) provides 
power to your hp Jornada while it is not connected to ac power. Under 
typical usage conditions (if you do not use the backlight), the fully charged 
main battery should provide power for up to 14 hours of use. Actual 
battery life will vary depending on how you use your hp Jornada. Some 
functions, such as listening to music, using the backlight, or operating 
CompactFlash cards, use considerable power and may reduce this time 
significantly. 
 

 
The hp Jornada extended battery pack, which offers twice the battery life of the 
standard battery, is available as an optional accessory. 

 

 

The main battery is charged whenever your hp Jornada is connected to an 
ac power source—either the ac adapter or the USB cradle. Connect your 
hp Jornada to ac power or place it in the cradle when it is not in use, to 
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ensure that the battery is fully charged when you need to take it with you. 
Charging the main battery takes approximately 3.5 hours. When the 
battery is fully charged, charging stops automatically; the battery will not 
overcharge if left connected to ac power. 
 

 

When the main battery charge is low, a low battery warning is displayed. If you
see a low battery warning message, connect to ac power and charge the main 
battery immediately to avoid draining the backup battery, and prevent possible 
data loss. 

 

 

Backup Battery 
The CR-2032 coin-cell backup battery protects your data when the main 
battery runs out of power. The backup battery does not provide enough 
power to operate your hp Jornada, but it will preserve your data for up to 
1 day after the low main battery warning is displayed. Connect to ac 
power to recharge the main battery.  

The backup battery is not recharged while your hp Jornada is connected to 
ac power. When you see a warning message indicating that the backup 
battery is low, you should replace the backup battery as soon as possible. 
To replace the backup battery, follow the instructions in step 2 under 
“Using Your hp Jornada for the First Time,” earlier in this chapter. 
 

 To prevent loss of data, replace the backup battery as soon as a warning 
message appears on your screen indicating that backup battery power is low.   
 

 
Do not mutilate, puncture, or dispose of batteries in fire. The batteries can burst 
or explode, releasing hazardous chemicals. Discard used batteries according to 
the manufacturer’s instructions.  

 

AC Power 
To avoid running out of battery power, you can operate your hp Jornada 
on ac power using the supplied ac adapter. The ac adapter accepts 
100 V to 240 V, enabling you to connect to ac power anywhere in the 
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world. When you travel, you may need adapters to accommodate different 
electrical outlets, but the hp Jornada ac adapter will safely convert ac line 
voltage to the dc voltage required by your hp Jornada.  

While your hp Jornada is connected to ac power, the main battery is 
charged automatically. The color of the LED indicates the status of the 
battery: amber indicates that the battery is charging, and green indicates 
that the battery is fully charged. 
 

 

If you will not be using your hp Jornada for an extended period of time, be sure 
to charge the main battery fully (or connect to ac power) before you store your 
hp Jornada.  

 

 

Turning Your hp Jornada On and Off 
One of the most convenient features of hp Jornada is “instant on.” With 
instant on, there is no waiting for your hp Jornada to start up or shut down; 
you can start working immediately by pressing the power button or one of 
the hp hot keys.  
 

 

You can also turn on your hp Jornada simply by tapping the touch screen. On 
the Power Preferences page in hp settings, select the Tap screen to power 
on check box. 

 

 
When you are finished working, turn off your hp Jornada by pressing the 
power button. By default, your hp Jornada will turn off automatically after 
1 minute of inactivity if it is not connected to an ac power source. You can 
use the Power control panel to change these settings. On the Start menu, 
tap Settings, tap the System tab, and then tap the Power icon.  

Using the Hardware Buttons 
The hardware buttons on your hp Jornada (that is, the buttons on the 
device itself, rather than buttons or icons that appear on the display) can 
each be used to perform several functions, such as turning on your hp 
Jornada or starting a particular program.  
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The features associated with each button are described below. In addition, 
most buttons can be reassigned or configured to start a program that you 
designate. For more information, see “Configuring Hardware Buttons” in 
chapter 6. 

Notification Button/LED 
• A blinking green LED indicates an alarm or reminder.  
• When your hp Jornada is connected to ac power, a solid green LED 

indicates that the main battery is fully charged.  
• A blinking amber LED indicates that your hp Jornada is on; however, 

the display is off. Press and hold the notification button/LED to turn the 
display on again. 

• A solid amber LED indicates that your hp Jornada is recording a voice 
note.  

• While your hp Jornada is connected to ac power, an amber LED may 
also indicate that the main battery is charging.  

• Press the notification button/LED to acknowledge an alarm or 
reminder and to silence the alarm.  

• Press and hold the notification button/LED to turn off the display.  
 

Up/Down Control 
• Press the up/down control to scroll through documents or to highlight 

items in a list.  

Record Button 
• Press and hold the record button to turn on your hp Jornada and begin 

recording a voice note. If the speaker is not muted, a beep indicates 
that recording has started. 

• Release the record button to stop recording. If the speaker is not 
muted, a double beep indicates that recording has stopped. 
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If your hp Jornada is off, pressing the record button will turn it on. To avoid 
inadvertently turning on your hp Jornada, you can disable the record button. For
more information, see “Adjusting Settings” in chapter 6. 

 

 

hp Hot Keys 
The hp hot keys can be reprogrammed to perform different functions or to 
open any program or document you want. The descriptions below refer to 
the default functions. For more information, see “Configuring Hardware 
Buttons” in chapter 6. 

  hp home menu hot key 
• Press the hp home menu hot key to launch the hp home menu 

application. 
• Press the hp home menu hot key a second time to display the next 

page of home menu buttons. 
• Press and hold the hp home menu hot key to launch the hp quick 

menu. Use the hp quick menu to open the Align Screen control panel 
or to turn off the display.  

 

  Contacts hot key 
• Press the Contacts hot key to open Pocket Outlook Contacts.  
• Press and hold the Contacts hot key to display the hp volume 

profile pop-up menu.  
• When working in Pocket Outlook Contacts, press the Contacts hot key 

to filter the Contacts list by category.  
 

  Calendar hot key 
• Press the Calendar hot key to launch the Pocket Outlook Calendar 

application. 
• Press and hold the Calendar hot key to display the hp display 

profile pop-up menu.  
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• When working in Pocket Outlook Calendar, press the Calendar hot 
key to change views (for example, to switch from Day view to Week 
view). 

 

 Tasks hot key 
• Press the Tasks hot key to open the Pocket Outlook Tasks application. 
• Press and hold the Tasks hot key to open hp task switcher.  

Power Button 
• Press the power button to turn your hp Jornada on or off. 
• Press and hold the power button to turn the backlight on or off. 
• If the display is off, press the power button to turn on the display.  

Navigation Pad and Action Button  
• Press the navigation pad to scroll through a document or to highlight 

the next item in a list. 
• Press the action button to select the highlighted item. The actions vary 

depending on the active program and the item selected. 

Caring for Your hp Jornada 
When treated properly, your hp Jornada will be a reliable personal digital 
assistant. Follow these tips to ensure long and trouble-free use of your hp 
Jornada: 

• Protect the screen. Pressing too hard on the touch screen may 
damage the screen. Use the stylus to tap the hp Jornada screen to 
avoid scratches or damage to the screen. To clean the screen, use a 
small amount of commercial glass cleaner sprayed on a soft cloth. 
Avoid spraying the screen directly.  

 

 
Be sure to turn off your hp Jornada before cleaning the touch screen. If your hp 
Jornada is set to power on when you tap the screen, change this setting before 
you clean the touch screen.  
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• Do not drop your hp Jornada. Dropping your hp Jornada can 

cause damage to delicate components such as the display. Accidental 
damage is not covered under the warranty.  

• Avoid radiated interference. Radiated interference from other 
electronic equipment may affect the appearance of the display of your 
hp Jornada. Removing the source of the interference will return the 
display to normal. 

• Avoid high temperatures. Your hp Jornada is designed to 
operate at temperatures between 0 to 40 ºC (32 to 104 ºF). 
Subjecting the device to temperatures outside this range may damage 
the unit or result in loss of data. Be especially careful not to leave your 
hp Jornada in direct sunlight or in a car where temperatures can rise 
to harmful levels. 

• Register your hp Jornada. To receive updates on exclusive 
promotions, exciting new products, and accessories, register your hp 
Jornada at www.hp.com/jornada. 
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3 | Overview of Microsoft 
Windows for Pocket PC  

This chapter covers all the basics of working with documents and programs 
on your hp Jornada. Once you master these simple skills and concepts, 
you will find that it is easy to get around on your hp Jornada.  

In this chapter you will learn how to 

• Navigate in Microsoft Windows for Pocket PC using the stylus. 
• Use the Today screen to view your day at a glance. 
• Switch programs using the Start menu, hp home menu, and hp task 

switcher. 
• Interpret status icons and other information on your hp Jornada screen. 
• Enter text in a variety of ways. 
• Record voice notes. 
• Find and organize information on your hp Jornada. 
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Navigating in Microsoft Windows for 
Pocket PC 
Your hp Jornada uses the Microsoft Windows for Pocket PC operating 
system. Navigating in Windows for Pocket PC is similar to navigating in 
Microsoft windows on your desktop PC, with features such as the Start 
menu, pop-up menus, and toolbars. 

Using the Stylus 
Use the stylus to navigate and select objects on the screen. 

• Tap.   Touch the screen once with the stylus to open items and select 
options. 

• Drag.   Hold the stylus on the screen and drag across the screen to 
select text and images. Drag in a list to select multiple items. 

• Tap and hold.   Tap and hold the stylus on an item to see a list of 
actions available for that item. On the pop-up menu that appears, tap 
the action you want to perform. 

Aligning the Touch Screen 
From time to time, you might notice that the accuracy of your stylus taps 
diminishes. When this happens, you can realign your touch screen using 
the Align Screen control panel.  

To open the Align Screen control panel 

1. Press and hold the hp home menu hot key to display the hp quick 
menu.  

2. Using the navigation pad, highlight Align Screen on the hp 
quick menu, and then click the action button.  

3. Tap the targets as they appear at each new location to align the 
touch screen.  
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Today Screen 
When you turn on your hp Jornada for the first time each day (or after 4 
hours of inactivity), you will see the Today screen. You can also display it 
by tapping  and then Today. On the Today screen, you can see at a 
glance important information for the day. 

����������	���
�����

����	�����	���������	���

����	�����	�
	�������
����

����	�����������	�����	�	���

����	�����
����	������	����

����	�����������	���

����	�����
��������������	�������������

����	����������	�������	����

 

Download from Www.Somanuals.com. All Manuals Search And Download.



24 | hp Jornada 560 series personal digital assistant User’s Guide  

Switching Programs 
Use the hp home menu application or the Start menu to quickly launch 
your favorite programs or open frequently used documents. You can also 
use hp task switcher to switch between running programs. 

To start or switch programs using the hp home menu 

1. Press the hp home menu hot key. 
2. Tap the button that corresponds to the program or document. 
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The hp home menu displays up to 10 pages of buttons and icons that 
represent the programs and documents on your hp Jornada. To change 
pages, tap the name of a page in the drop-down list at the top of the hp 
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home menu screen, or tap the arrows  or  to display the next or 
previous page.  
 

 The battery icon at the bottom of the hp home menu changes to indicate when 
power is low.  Tap the icon to open the Power control panel.  
 

To start or switch programs using the Start menu 

1. Tap  in the Navigation bar to display the Start menu. 
2. On the Start menu, tap the name of the program you want to 

switch to. 
–or– 
Tap one of the miniature icons at the top of the Start menu to 
switch to a recently used program. 

 

 
You can customize both the hp home menu and the Start menu to make it 
easier to access the programs you use most. For more information, see 
“Configuring Menus” in chapter 6.  

 

To switch programs using hp task switcher 

1. On the Today screen, tap the hp task switcher status icon, , in 
the Command bar.  
–or– 
Press and hold the Tasks hot key to open hp task switcher.  

2. On the pop-up menu, tap the name of one of the running 
programs.  
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The hp task switcher pop-up menu

Navigation Bar and Command Bar 
The Navigation bar is located at the top of the screen. It displays the active 
program and current time, and allows you to switch programs and close 
screens.  

Use the Command bar at the bottom of the screen to perform tasks in 
programs. The Command bar includes menu names, buttons, and the Input 
panel button. To create a new item in the current program, tap New. To 
see the name of a button, tap and hold the stylus on the button. Drag the 
stylus off the button so that the command is not carried out. 
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Tap to select a program.

Tap to change volume or mute the device.

Tap to see additional programs.

Tap to customize the device.

Tap to quickly select a program
you have recently used.

 
The Navigation bar and Start menu

New button.

Menu
names.

Buttons.

Input panel button.

 
The Pocket PC Command bar
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Status Icons 
When the Today screen is displayed, you may see the following status 
icons on the Command bar or Navigation bar. In most cases, you can tap 
a status icon to display the associated control panel or more information 
related to the item. For example, tap a battery status icon to open the 
Power control panel.  
 
Icon Meaning 

 
Speaker is on  

 
Speaker is off 

 
hp task switcher is running 

 
hp emergency backup is activated 

 
Backup battery is low  

 
Main battery is charging  

 
Main battery is low  

 
Main battery is very low  

 
Main battery is fully charged 

 
Connection is active  

 
Synchronization is beginning or ending 

 
Synchronization is occurring 

  

 

If there is not enough room to display all the notification icons that need to be 
displayed, the Notification icon, , will appear. Tap the icon to view all 
notification icons. 
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Pop-Up Menus 
With pop-up menus, you can quickly choose an action for an item. For 
example, you can use the pop-up menu in the contact list to quickly delete 
a contact, make a copy of a contact, or send an e-mail message to a 
contact. The actions in the pop-up menus vary from program to program. 
To access a pop-up menu, tap and hold the stylus on the name of the item 
that you want to perform the action on. When the menu appears, lift the 
stylus, and tap the action you want to perform. Or tap anywhere outside 
the menu to close the menu without performing an action. 

Tap and hold to display
the pop-up menu.

Lift the stylus and tap
the action you want.

Tap outside the menu
to close it without performing
an action.

 

Download from Www.Somanuals.com. All Manuals Search And Download.



30 | hp Jornada 560 series personal digital assistant User’s Guide  

Alerts and Notifications 
Your hp Jornada reminds you in a variety of ways when you have 
something to do. For example, if you have set up an appointment in 
Calendar, a task with a due date in Tasks, or an alarm in Clock, you will 
be notified in any of the following ways: 

• A message appears on the screen. 
• A sound, which you can specify, is played. 
• The notification button/LED flashes.  
 
To choose reminder types and sounds for your hp Jornada, tap Settings 
on the Start menu. On the Personal tab, tap Sounds & 
Notifications.  

Entering Information  
You have several options for entering new information: 

• Use the Input panel to enter typed text, either by using the soft 
keyboard or other input method. 

• Write directly on the screen. 
• Draw pictures on the screen. 
• Speak into the microphone to record a message. 
 

Entering Text Using the Input Panel  
Use the Input panel to enter information in any program on your hp 
Jornada. You can either type using the soft keyboard or write using 
AccessPanel, the soft keyboard, Block Recognizer, Letter Recognizer, or 
Transcriber. In any case, the characters appear as typed text on the 
screen.  

To show or hide the Input panel, tap the Input panel button. Tap the arrow 
next to the Input panel button to see your choices. 
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When you use the Input panel, your hp Jornada anticipates the word you 
are typing or writing and displays it above the Input panel. When you tap 
the displayed word, it is inserted into your text at the insertion point. The 
more you use your hp Jornada, the more words it learns to anticipate. 
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Tap here if this
is the right word.

 

 

To change word suggestion options, such as the number of words suggested at 
one time, tap Settings on the Start menu. On the Personal tab, tap Input, 
and then tap the Word Completion tab. 

 

 

AccessPanel 
AccessPanel helps you speed data entry by giving you “tap-and-go” 
access—you can instantly paste common phrases, contact information, or 
date and time stamps into any application. Use AccessPanel to add your 
signature to e-mail messages, paste salutations into letters, or add dates 
and times to your memos. 
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When you open AccessPanel, the phrase list selection buttons are 
displayed on the left side of the window. These buttons activate a list of 
your text phrases, date and time stamps, or contacts. 

To start AccessPanel 

1. In a note or document, position the insertion point where you want 
to insert the text.  

2. Tap the arrow next to the Input panel button, and then tap 
AccessPanel. 

3. Tap a button to display the text phrase list, date and time list, or 
contacts list. 

4. Double-tap an entry in the AccessPanel list to insert the text into 
the document. 
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The first time you run AccessPanel, you are prompted to install a set of sample 
phrases that help illustrate the use of AccessPanel. Installing the samples will 
provide ideas that you can use to create your own custom phrases to paste into 
applications. 

 

 
For more information on using AccessPanel Platinum, tap  to display 
online Help, or refer to the AccessPanel Platinum User Guide on the Pocket 
PC Companion CD.  

Block Recognizer 
With Block Recognizer, you can use the stylus to input characters using 
strokes that are similar to the Palm™ Graffiti® method. 

To type with Block Recognizer 

1. Tap the arrow next to the Input panel button, and then tap Block 
Recognizer. 

2. Write a letter in the box. 
 
When you write a letter, it is converted to typed text that appears on the 
screen. For specific instructions on using Block Recognizer, open Block 
Recognizer, and then tap the question mark next to the writing area. 

Soft Keyboard 
The soft keyboard is an onscreen keyboard displayed at the bottom of the 
screen.  

To type with the soft keyboard 

1. Tap the arrow next to the Input panel button, and then tap 
Keyboard. 

2. On the soft keyboard that is displayed, tap the keys with your 
stylus. 
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Letter Recognizer 
With Letter Recognizer, you can write letters using the stylus just as you 
would use a pen on paper. 

To type with Letter Recognizer 

1. Tap the arrow next to the Input panel button, and then tap Letter 
Recognizer. 

2. Write a letter in the box. 
 
When you write a letter, it is converted to typed text that appears on the 
screen. For specific instructions on using Letter Recognizer, open Letter 
Recognizer and then tap the question mark next to the writing area. 

Transcriber 
With Transcriber you can write anywhere on the screen using the stylus just 
as you would on paper. Unlike Letter Recognizer and Block Recognizer, 
you can write a sentence or more of information; then, you pause and let 
Transcriber change the written characters to typed characters. 

To type with Transcriber 

1. Tap the arrow next to the Input panel button, and then tap 
Transcriber. 

2. Write anywhere on the screen. 
 
For specific instructions on using Transcriber, open Transcriber and then 
tap the question mark in the lower-right corner of the screen. 

Writing on the Screen 
In any program that accepts writing—such as the Notes program and the 
Notes tab in Calendar, Contacts, and Tasks—you can use your stylus to 
write directly on the screen. Write the way you do on paper. You can edit 
and format what you have written and convert the information to text later. 

To write on the screen 

• Tap the Pen button to switch to writing mode. This action displays 
lines on the screen to help you write. 
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Tap the Pen button and use
your stylus like a pen.  

 

 
Some programs that accept writing may not have the Pen button. See the 
documentation for that program to find out how to switch to writing mode.  

 
If you want to edit or format writing, you must select it first. 

To select writing 

1. Tap and hold the stylus next to the text you want to select until the 
insertion point appears. 

2. Without lifting, drag the stylus across the text you want to select. 
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If you accidentally write on the screen, tap Tools, then Undo, and try 
again. You can also select text by tapping the Pen button to deselect it and 
then dragging the stylus across the screen. 

You can cut, copy, and paste written text in the same way you work with 
typed text: tap and hold the selected words and then tap an editing 
command on the pop-up menu, or tap the command on the Edit menu. 

To convert writing to text 

• On the Tools menu, tap Recognize. 
 
If you want to convert only certain words, select them before tapping 
Recognize on the Tools menu (or tap and hold the selected words and 
then tap Recognize on the pop-up menu). If a word is not recognized, it 
is left as writing. 

Select the text you want
to convert and tap Recognize on the
pop-up menu.

The writing is turned into
text.  

If the conversion is incorrect, you can select different words from a list of 
alternates or return to the original writing. To do so, tap and hold the 
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incorrect word (tap one word at a time). On the pop-up menu, tap 
Alternates. A menu with a list of alternate words appears. Tap the word 
you want to use, or tap the writing at the top of the menu to return to the 
original writing. 

Or, tap the word you want
to use.

Tap to return to your
original writing.

 

Some tips for getting good recognition are listed below: 

• Write neatly. 
• Write on the lines and draw descenders below the line. Write the 

cross of the “t” and apostrophes below the top line so that they are not 
confused with the word above. Write periods and commas above the 
line. 

• For better recognition, use the Tools menu to increase the zoom level 
to 300%. 

• Write the letters of a word close together and leave big gaps between 
words. 
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• Hyphenated words, foreign words that use special characters such as 
accents, and some punctuation cannot be converted. 

• If you add writing to a word to change it (such as changing a “3” to 
an “8”) after you attempt to recognize the word, the writing you add 
will not be included if you attempt to recognize the writing again.  

Drawing on the Screen 
You can draw on the screen in the same way that you write on the screen. 
The difference between writing and drawing on the screen is how you 
select items and how they can be edited. For example, selected drawings 
can be resized, while writing cannot. 

To create a drawing 

• Cross three ruled lines on your first stroke. A drawing box 
appears. Subsequent strokes in or touching the drawing box 
become part of the drawing. Drawings that do not cross three 
ruled lines will be treated as writing. 
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The drawing box indicates
the boundaries of the drawing.

Pen button.  

 

 
You may want to change the zoom level so that you can more easily work on or 
view your drawing. Tap Tools, and then choose a zoom level. 

 

 
If you want to edit or format a drawing, you must select it first. 

To select a drawing 

• Tap and hold the stylus on the drawing until the selection handle 
appears. To select multiple drawings, deselect the Pen button and 
then drag to select the drawings you want. 

 
You can cut, copy, and paste selected drawings by tapping and holding 
the selected drawing and then tapping an editing command on the pop-up 
menu, or by tapping the command on the Edit menu. To resize a drawing, 
make sure the Pen button is not selected, and then drag a selection handle. 
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Recording a Message 
In any program where you can write or draw on the screen, you can also 
quickly capture thoughts, reminders, and phone numbers by recording a 
message. In Calendar, Tasks, and Contacts, you can include a recording 
in the Notes tab. In the Notes program, you can either create a stand-
alone recording or include a recording in a written note. If you want to 
include the recording in a note, open the note first. In the Inbox program, 
you can add a recording to an e-mail message.  

To create a recording 

1. Hold the hp Jornada’s microphone near your mouth or other 
source of sound. 

2. Press and hold the record button. If the speaker is not muted, a 
beep indicates that your hp Jornada is recording. The notification 
button/LED shines steady amber while recording is in progress.  

3. While holding down the record button, speak into the 
microphone. 

4. To stop recording, release the record button. Two beeps will 
sound. The new recording appears in the note list or as an 
embedded icon. 

 

 You can also make a recording by tapping the Record button on the Recording 
toolbar.  
 

To play a recording 

• Tap it in the list or tap its icon in the note. 
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Indicates an embedded
recording.

Tap to show or hide
the Recording toolbar.

Tap to begin recording.

 

Recording Formats 
Your hp Jornada supports several formats for voice notes. The formats vary 
in both the quality of the recording and the size of the sound file. When 
selecting a recording format, you should consider the quality you need as 
well as how much storage memory the recording will use on your hp 
Jornada. 

Not all recording formats are compatible with other software or computers. 
If you will share your recordings with others or transfer a recording to your 
desktop PC, be sure to choose a recording format that is supported by the 
software used to play recordings on the other computer.  

The PCM format offers the highest quality recording, and is compatible 
with all hp Jornada models, other Windows-powered mobile devices, and 
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desktop PCs that use Windows operating systems. The GSM 6.10 format 
is compatible with all hp Jornada models and other Windows-powered 
mobile devices, but may not work with desktop PCs.  

To select a recording format 

1. On the Start menu, tap Settings, and then tap the Input icon. 
2. On the Options tab in the Input control panel, select a voice 

recording format from the drop-down list.  
 
The list of recording formats on your hp Jornada indicates the sample rate, 
whether the format is stereo or mono, and how much storage memory is 
required per second of recording. You may need to experiment with 
different sample rates and formats to determine which format best suits 
your voice. 
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Using My Text 
When using Inbox or MSN Messenger, use My Text to quickly insert preset 
or frequently used messages into the text entry area. To insert a message, 
tap My Text, and then tap a message. 

Tap to select a
prewritten message.  

 

 
After inserting a My Text message, you can add text to it before you send the 
message.  

 
To edit a My Text message, on the Tools menu, tap Edit, and then tap 
My Text Messages. Select the message you wish to edit and make 
desired changes. 
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Finding and Organizing Information 
The Find feature on your hp Jornada helps you quickly locate information.  

To find a file 

• On the Start menu, tap Find. Enter the text you want to find, 
select a data type, and then tap Go to start the search. 

 

 
To quickly find information that is taking up storage space on your hp Jornada, 
select Larger than 64 KB under Type.  
 
You can also use the File Explorer to find files on your hp Jornada and to 
organize these files into folders. On the Start menu, tap Programs, and 
then tap File Explorer. 

Tap the folder name
to open it.

Tap and hold to create
a new folder.

Select the sort order
for the list.

Tap to change folders.
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You can move files in File Explorer by tapping and holding the item you want to 
move, tapping Cut or Copy on the pop-up menu, browsing to the new location,
and then tapping Paste. 
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4 | Connecting to Your Desktop PC 

To get the most from your hp Jornada, you will want to connect to your 
desktop or notebook PC. This chapter describes how to establish the 
connection between your hp Jornada and your desktop PC, and how to 
synchronize and transfer files between your hp Jornada and your desktop 
(or any PC that has Microsoft ActiveSync installed). In this chapter, you will 
learn to 

• Install Microsoft ActiveSync on your desktop PC. 
• Use ActiveSync to synchronize data between your hp Jornada and 

desktop PC. 
• Connect your hp Jornada to your desktop PC using either the USB 

cradle or the infrared port.  
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Microsoft ActiveSync  
Microsoft ActiveSync enables you to synchronize the information on your 
desktop PC with the information on your hp Jornada. In addition, you can 
back up data from your hp Jornada to your desktop PC and restore this 
data to your hp Jornada, and copy files between your hp Jornada and 
desktop PC.  

Before you begin synchronization, install ActiveSync on your desktop PC 
from the Pocket PC Companion CD. ActiveSync is already installed on 
your hp Jornada. 

After installation is complete, the ActiveSync Setup Wizard helps you 
connect your hp Jornada to your desktop PC, set up a partnership so you 
can synchronize information between your hp Jornada and your desktop 
computer, and customize your synchronization settings. Your first 
synchronization process will begin automatically when you finish using the 
wizard. 

Synchronizing Data 
Synchronization compares the data on your hp Jornada with your desktop 
PC and updates both computers with the most recent information. For 
example, you can 

• Synchronize Microsoft Word and Microsoft Excel files between your 
hp Jornada and desktop PC. Your files are automatically converted to 
the correct format.  

• Synchronize e-mail messages in your hp Jornada Inbox with e-mail 
messages in Microsoft Outlook on your desktop PC. 

• Copy favorite Web site addresses and any Web pages you have 
marked for offline viewing in Microsoft Internet Explorer to your hp 
Jornada.  

• Keep your Pocket Outlook Contacts, Calendar, and Tasks databases 
up-to-date by synchronizing your hp Jornada with Microsoft Outlook 
data on your desktop PC.  

 

 
Synchronization with Microsoft Outlook 2002 requires ActiveSync 3.5 on the 
desktop PC.  
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After you synchronize, the information you have stored on your desktop PC 
is copied to your hp Jornada so you can take it with you when you go. 
Use ActiveSync options to select which information types are synchronized 
and to control how much data is synchronized. For example, if you choose 
to synchronize Calendar data, you can specify how many weeks of past 
appointments you want synchronized. By default, ActiveSync does not 
automatically synchronize all types of information. Use ActiveSync options 
to turn synchronization on and off for specific information types. 

After you have set up ActiveSync and completed the first synchronization, 
you can control when synchronization occurs by selecting a 
synchronization mode. For example, you can synchronize continually 
while your hp Jornada is in the cradle, or only when you choose the 
Synchronize command.  

To start synchronization from your hp Jornada 

1. Connect your hp Jornada to your desktop PC. For more 
information, see “Connecting Your hp Jornada,” below. 

2. On the Start menu, tap ActiveSync. 
3. Tap  to begin synchronization.  
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Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.

 
For detailed instructions on setting ActiveSync options and using 
ActiveSync on your desktop PC, see ActiveSync Help on the desktop PC. 
For more information on using ActiveSync on your hp Jornada, see 
ActiveSync Help on your hp Jornada.  

Synchronizing from a Remote Location 
You can also synchronize while your hp Jornada is connected to your 
desktop PC using a dial-up modem connection or over a network.1 This can 
be useful if you need to synchronize files or PIM information while 
traveling. Before you leave, you must configure both your hp Jornada and 
your desktop PC. 

1 Requires an optional modem and/or an account with an Internet service 
provider. 
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On your hp Jornada 

Create a partnership between your hp Jornada and the desktop PC using 
one of the direct connection methods (USB cradle or infrared connection) 
described in this chapter. You must also configure a connection on your hp 
Jornada, as described in chapter 5, “Connecting to the Internet or to a 
Network.“ 

On your desktop PC 

Before you can synchronize remotely, the desktop PC or network server 
must be configured to allow your hp Jornada to connect. Depending on the 
version of Windows running on the desktop PC, you may need to install 
and configure Remote Access Services or Dial-Up Networking on the 
desktop PC.  

You must also ensure that ActiveSync is configured to allow a network 
connection. For more information, see ActiveSync Help on your desktop 
PC. 

Follow these steps to prepare your desktop PC before you leave: 

• If you are using a modem on your desktop PC, turn the modem on 
before you leave. 

• Leave your desktop PC on, and be sure you logged on under the same 
user name that you used when you created the partnership. 

• Ensure your PIM program and e-mail program (Microsoft Outlook or 
Microsoft Exchange) are running. 

If you receive an error message on your hp Jornada that states that an 
information type needs attention, or if unresolved items are reported after 
synchronization, you must synchronize directly with your desktop PC using 
the USB cradle, an infrared connection, or an optional serial cable. 

Copying Files Between Your hp Jornada  
and Your Desktop PC 
You can copy files between your hp Jornada and desktop PC by dragging 
icons to or from the Mobile Device window or by using the Cut, Copy, 
and Paste commands on the Edit menu.  

Files created on your desktop PC may need to be converted before you 
can use them on your hp Jornada, and files created on your hp Jornada 
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may need to be converted before you can use them on your desktop PC. 
By default, ActiveSync automatically converts files to the appropriate type; 
however, you can choose not to convert files, or you can choose to specify 
the conversion for each type of file by changing options in ActiveSync.  

Backing Up Data with ActiveSync 
To prevent loss of data, you should back up your hp Jornada frequently 
using either Microsoft ActiveSync or the hp backup application. When you 
back up your hp Jornada using ActiveSync, the backup file contains all the 
files, databases, PIM information, and RAM-based programs on your hp 
Jornada. The backup file is stored on your desktop PC.  
 

 

hp backup enables you to back up your PIM databases to a CompactFlash 
memory card or to the hp safe store folder on your hp Jornada. For more 
information on hp backup and hp emergency backup, see “Backing Up and 
Restoring Data” in chapter 6.  

 

 
If you have established a partnership between your hp Jornada and 
desktop PC, you can set ActiveSync to back up data automatically each 
time you connect. You can also back up your hp Jornada manually any 
time you want. ActiveSync lets you decide whether to back up all data 
each time, or only new and updated information.  

When you use the backup file to restore data to your hp Jornada, data on 
your hp Jornada is replaced with the data stored in the backup file. If you 
have created files on your hp Jornada since the last backup and do not 
want to delete these files during the restore process, move the files from 
your hp Jornada to your desktop PC before restoring data. You can restore 
data using ActiveSync or the hp backup application. 
 

 
Restoring data from ActiveSync replaces all data stored on your hp Jornada. 
Any data added after the backup file was created will be lost.   

 
For more information on backing up and restoring data using Microsoft 
ActiveSync, see ActiveSync Help on your desktop PC. 
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Connecting Your hp Jornada 
You can connect your hp Jornada to a desktop computer in several ways: 

• Using the USB cradle that is included with your hp Jornada. The USB 
cradle connects to a USB port on your desktop PC.  

• Using the infrared port on your hp Jornada. You can connect your hp 
Jornada to an infrared-equipped desktop or notebook PC using the 
infrared port. Many notebook PCs have built-in infrared ports; 
however, you may need to purchase and install an infrared transmitter 
for your desktop PC. 

• Over a network or dial-up connection. You can synchronize while 
connected to your desktop PC by a dial-up (modem) connection or 
over a local area network (LAN). 

• Using a serial cable or cradle. If your desktop PC does not have a 
USB port or an infrared transmitter, or if your operating system does 
not support these connection methods, you can purchase an optional 
serial cable or serial cradle that enables you to connect your hp 
Jornada to a serial port. Instructions on establishing a serial 
connection are included with these accessories. Note that Windows 
95 and Windows NT® do not support USB or infrared connectivity. 

 

 Install ActiveSync on your desktop PC before connecting your hp Jornada by 
USB.   
 

Connecting by USB Cradle  
The USB cradle included with your hp Jornada provides a convenient way 
to connect to your desktop PC. In addition to enabling synchronization, the 
USB cradle charges the main battery on your hp Jornada. Keep your hp 
Jornada in the cradle when you are not carrying it with you, so it is always 
charged, synchronized, and ready to go. 
 

 
Do not shut down or restart your desktop PC while your hp Jornada is 
connected. Turn off your hp Jornada or remove it from the cradle before you 
shut down your desktop PC.  
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Before you connect, be sure of the following: your desktop PC is on, you have 
installed ActiveSync on your desktop PC, and ActiveSync is configured to allow 
a USB connection. 

 

 

To connect by USB cradle 

1. Connect the dc plug from the ac adapter to the dc jack on the 
cradle cable, and plug the ac adapter into a wall outlet.  

2. Connect the cable from the cradle to a USB port on your desktop 
PC. 

3. If you have installed an optional extended battery pack, remove 
the expansion panel from the face of the cradle.  

4. Slide your hp Jornada into the cradle. Your hp Jornada should 
start automatically and establish a connection to the desktop PC. 

 

 
Connecting to your PC
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When you remove your hp Jornada from the cradle, hold the cradle down with 
one hand, and gently lift the hp Jornada with the other to avoid putting stress on 
the connectors.  

 

Connecting by Infrared 
The infrared port on your hp Jornada provides a convenient way to 
connect to an IrDA-equipped PC without using a cable or cradle. Many 
notebook computers have built-in infrared ports; however, you may need to 
install and configure an infrared port on a desktop PC. To install the port, 
follow the manufacturer’s instructions. More information about infrared 
drivers for Microsoft Windows is available on the Microsoft Mobile 
Devices Web site at www.microsoft.com/mobile/pocketpc. 

For complete instructions on connecting to your desktop PC by infrared, 
refer to ActiveSync Help on your desktop PC.  
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5 | Connecting to the Internet  
or to a Network 

In addition to connecting your hp Jornada to your desktop PC, you may 
want to connect to remote computers so you can access e-mail, browse the 
Internet, or retrieve files from a corporate network, whether you are at 
home or on the road. This chapter describes 

• the several methods you can use to connect your hp Jornada to a 
modem, mobile phone, or network 

• the process of configuring your hp Jornada to connect to an Internet 
service provider (ISP) or network 

• browsing the Web (or a corporate intranet) from your hp Jornada 
using Microsoft Pocket Internet Explorer and Mobile Favorites 

• sending and receiving e-mail messages with your hp Jornada 
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Connecting your hp Jornada  
Your hp Jornada gives you several options for connecting to a remote 
computer. You can use an optional CompactFlash card modem, an 
infrared modem, or a mobile phone. Each of these methods requires 
purchase of a modem or adapter as an optional accessory. For more 
information about compatible modems and accessories, visit the hp 
Jornada Web site at www.hp.com/jornada. 

Connecting with a CompactFlash Card 
Your hp Jornada supports a variety of CompactFlash card modems and 
network interface cards (NICs). Whether you use a CompactFlash modem 
or CompactFlash NIC, the card must be a CompactFlash Type I or 
CompactFlash Type I extended card. For a list of compatible 
CompactFlash cards, go to the hp Jornada accessories page at 
www.hp.com/jornada. For instructions on how to install a CompactFlash 
card in your hp Jornada, see “Accessories” in Chapter 6. 

Many NICs also require that you install a software driver. The card manu-
facturer must provide a software driver for the hp Jornada. Follow the card 
manufacturer’s instructions for installing the card and configuring the driver 
for use with your hp Jornada. 

After you have installed and configured the card, the make and model of 
the card will appear in the list of modems or the list of network adapters 
when you create a new connection (see “Creating an ISP or Network 
Connection,” later in this chapter). 

When you are ready to connect, connect the CompactFlash card to an 
analog telephone line or a network connection using the appropriate 
cable. Follow the card manufacturer’s instructions to attach the cable to the 
port on the card.  
 

 
Do not connect a CompactFlash modem to a digital telephone line unless it is 
specifically designed for use with a digital line.  
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Connecting with an Infrared Modem 
You can also use the infrared port on your hp Jornada to connect to the 
Internet or a remote computer via an IrDA-compatible infrared modem. 
When you create a new dial-up connection, select Generic IrDA 
modem from the modem list. Connect the modem to a phone line 
according to the manufacturer’s instructions, and align the infrared port on 
your hp Jornada with the infrared port on the modem before dialing the 
call. 

Connecting with a Mobile Phone  
If your mobile phone service supports remote data connection, you can use 
the mobile phone to connect your hp Jornada to the Internet or to a remote 
computer. Depending on the make and model of your mobile phone, you 
can connect your hp Jornada to the mobile phone using either a Compact-
Flash card interface or the infrared port.  

CompactFlash Connectivity Kit 
You may be able to obtain a CompactFlash Type I or Type I extended 
connectivity kit from the manufacturer of your phone, or from a third-party 
manufacturer. In either case, the kit must be designed to work with the 
specific model of your phone, and the manufacturer must provide a driver 
for use with the hp Jornada.  

After you have installed and configured the card, the make and model of 
the card will appear in the list of modems or the list of network adapters 
when you create a new connection (see “Creating an ISP or Network 
Connection,” later in this chapter). 

Via Infrared 
If your mobile phone has a built-in IrDA-compatible infrared port (or if an 
optional infrared connectivity kit is available for your phone), you can use 
the infrared port on your hp Jornada to connect. When you create a new 
dial-up connection, select Generic IrDA modem from the modem list. 
Align the infrared port on your hp Jornada with the infrared port on the 
mobile phone before dialing the call. For detailed instructions on how to 
establish a wireless connection using a mobile phone, check the hp 
Jornada Web site at www.hp.com/jornada. 
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Creating an ISP or Network Connection  
To connect to a network or the Internet, you need an account with an ISP, 
an account on your corporate network, or access permission to dial in to a 
specific computer. 

For each account, you will need a user name and password provided by 
the ISP or account administrator. If you are connecting to a commercial 
ISP, you will also need to know the dial-up telephone number, and IP and 
DNS addresses (if required). 

If you plan to use the account to send or receive e-mail messages directly 
from your hp Jornada, you must also obtain the following information from 
your ISP or account administrator: 

• A user name and password for your e-mail account. (These may be 
different from the user name and password you use to connect.) 

• The name of the POP3 or IMAP4 server (for incoming messages). 
• The name of the SMTP server (for outgoing messages).  
 
Before you can use a modem to connect to an ISP or to dial in to a specific 
desktop PC, you must create a connection for that service on your hp 
Jornada. If you use an NIC to connect to a corporate network, you must 
configure your network connection. Your hp Jornada will recognize the 
connection after you attach the network cable to the NIC.  

To create a modem connection to an ISP 

1. Get the following information from your ISP: ISP dial-up access 
telephone number, user name, password, and TCP/IP settings.  

2. On the Start menu, tap Settings. On the Connections tab, tap 
Connections.  

3. In the automatic Internet connection options, select Internet 
Settings, and then tap Modify. 

4. On the Modem tab, tap New. 
5. Enter a name for the connection, such as “ISP Connection.” 
6. In the Select a modem list, select your modem type.  
7. You should not need to change any advanced settings. Most ISPs 

assign IP addresses dynamically. If the ISP you are connecting to 
does not use a dynamically assigned IP address, tap Advanced, 
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and then enter the address on the TCP/IP tab. Tap OK, and then 
tap Next. 

8. Enter the access phone number or dial string, and then tap Next. 
9. Select other desired options, and then tap Finish. 
10. On the Dialing tab, specify your current location and phone 

type. These settings will apply to all connections you create. 
 
To open the connection, simply open a program that requires a connection 
to the Internet. Your hp Jornada will attempt to connect automatically. 
Once connected, you can: 

• Send and receive e-mail messages by using Inbox. Before you can use 
Inbox, you need to provide the information it needs to communicate 
with the e-mail server. For specific instructions, see “Connecting 
Directly to an E-mail Server,” later in this chapter. 

• Visit Web and WAP pages by using Pocket Internet Explorer. For 
more information, see “Browsing the Web (or a Corporate Intranet),” 
later in this chapter. 

• Send and receive instant messages with MSN Messenger. For more 
information, see “MSN Messenger” in chapter 8. 

To create a modem connection to a network 

1. Get the following information from your network administrator: 
dial-up access telephone number, user name, password, domain 
name, and TCP/IP settings. 

2. On the Start menu, tap Settings. On the Connections tab, tap 
Connections.  

3. In the automatic Internet connection options, select Internet 
Settings, and then tap Modify. 

4. On the Modem tab, tap New. 
5. Enter a name for the connection, such as “Company Connection.” 
6. In the Select a modem list, select your modem type.  
7. You should not need to change any advanced settings. Most 

servers now use a dynamically assigned address. If the server you 
are connecting to does not use a dynamically assigned address, 
tap Advanced, and then enter the address on the TCP/IP tab. 
Tap OK, and then tap Next. 
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8. Enter the access phone number or dial string, and then tap Next. 
9. Select other desired options, and then tap Finish. 
10. On the Dialing tab, specify your current location and phone type 

(most phone lines are tone). These settings will apply to all 
connections you create. 

 
To start the connection, simply open a program that requires a connection 
to the Internet. Your hp Jornada will attempt to connect automatically. 
Once connected, you can: 

• Send and receive e-mail messages by using Inbox. Before you can use 
Inbox, you need to provide the information it needs to communicate 
with the e-mail server. For specific instructions, see “Connecting 
Directly to an E-mail Server,” later in this chapter. 

• Visit Internet or intranet Web or WAP pages by using Pocket Internet 
Explorer.  

• Send and receive instant messages with MSN Messenger. For more 
information, see “MSN Messenger” in chapter 8. 

• Synchronize data with a computer on the network. For more 
information, see ActiveSync Help on your desktop PC.  

 

Closing a Connection  
If you opened the connection from a program, such as Inbox or Pocket 
Internet Explorer, close that program first. To disconnect, do one of the 
following: 

• When connected via a dial-up or network connection, tap the 
Connection icon, , on the Navigation bar, and then tap End.  

• When connected via cable or cradle, detach your device from the 
cable or cradle.  

• When connected via infrared, move the device away from the desktop 
PC.  

• When connected via a network (Ethernet) card, remove the card from 
your device. 

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 5 | Connecting to the Internet | 63 

Get Help on Connecting 
More information on the procedures described here, as well as information 
on additional procedures, can be found in the following locations: 

• “Inbox: Sending and Receiving E-mail Messages” in this chapter 
• Online Help on your hp Jornada 
• ActiveSync Help on your desktop PC 
 
For troubleshooting information, see “Troubleshooting Remote 
Connections” in chapter 9, or visit the Microsoft Mobile Devices Web site 
at www.microsoft.com/mobile/pocketpc. 
 

Browsing the Web (or a Corporate Intranet) 
Once you are connected to an ISP or to a network, you can browse the 
Internet or a corporate intranet. You can also use Pocket Internet Explorer 
to browse Web and WAP content while you are not connected—by 
downloading mobile favorites and channels to your hp Jornada. 

Using Microsoft Pocket Internet Explorer 
Use Microsoft Pocket Internet Explorer to view Web pages in either of 
these ways: 

• Connect to an ISP or network and browse the Web. To do this, you 
will need to create the connection first, as described in “Creating an 
ISP or Network Connection,” earlier in this chapter. 

• During synchronization with your desktop PC, download your favorite 
links and mobile favorites that are stored in the Mobile Favorites 
subfolder in Internet Explorer on the desktop PC. 

While you are connected to an ISP or network, you can also download 
files and programs from the Internet or an intranet. 

To start Pocket Internet Explorer 

• On the Start menu, tap Internet Explorer.  
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To view mobile favorites and channels 

1. Tap the Favorites button to display your list of favorites.  
2. In the list, tap the page you want to view.  

Tap to add or delete
a folder or favorite link.

Tap the favorite you
want to view.

 

You will see the page that was downloaded the last time you synchronized 
with your desktop PC. If the page is not on your hp Jornada, it will be 
dimmed in the Favorites list. You will need to synchronize with your 
desktop PC again to download the page to your hp Jornada, or connect to 
the Internet to view the page. 

To browse the Internet 

1. Set up a connection to your ISP or corporate network, as 
described in this chapter. 

2. To connect and start browsing, do one of the following: 
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• Tap the Favorites button, and then tap the favorite you want 
to view. 

• Tap View, and then tap Address Bar. In the address bar 
that appears at the top of the screen, enter the Web address 
you want to visit and then tap Go. Tap the arrow to choose 
from previously entered addresses. 

 

The Mobile Favorites Folder 
Only items stored in the Mobile Favorites subfolder in the Favorites folder 
in Internet Explorer on your desktop PC will be synchronized with your hp 
Jornada. This folder is created automatically when you install ActiveSync.  

Favorite Links 
During synchronization, the list of favorite links in the Mobile Favorites 
folder on your desktop PC is synchronized with Pocket Internet Explorer on 
your hp Jornada. Both computers are updated with changes made to either 
list each time you synchronize. Unless you mark the favorite link as a 
mobile favorite, only the link (and not the page) will be downloaded to 
your hp Jornada, and you must connect to your ISP or network to view the 
content. For more information on synchronization, see ActiveSync Help on 
your desktop PC.  

Mobile Favorites  
If you are using Microsoft Internet Explorer 5 or later on your desktop PC, 
you can download mobile favorites to your hp Jornada. When you 
synchronize your desktop PC and hp Jornada, the content of your mobile 
favorites is downloaded to your hp Jornada so that you can view pages 
while you are not connected to your ISP or your network. 

Use the Internet Explorer plug-in installed with ActiveSync to create mobile 
favorites quickly.  

To create a mobile favorite 

1. In Internet Explorer on your desktop PC, click Tools, and then 
click Create Mobile Favorite. 
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• To change the link name, enter a new name in the Name 
box.  

• To change how often the mobile favorite is updated, select 
a desired update schedule under Update.  

 
2. Click OK. Internet Explorer downloads the latest version of the 

page to your desktop PC. 
3. If you want to download the pages that are linked to the mobile 

favorite you just created, right-click the mobile favorite and then 
click Properties. On the Download tab, specify the number of 
links deep you want to download. To conserve memory on your 
hp Jornada, download only one level of links. 

4. Synchronize your device and desktop PC. Mobile favorites that 
are stored in the Mobile Favorites folder in Internet Explorer are 
downloaded to your hp Jornada. 

 

 

If you do not specify an update schedule, you must manually download content 
to keep the information updated on your desktop PC and hp Jornada. Before 
synchronizing, in Internet Explorer on your desktop PC, click Synchronize on 
the Tools menu. You will see the last time content was downloaded to the 
desktop PC, and you can manually download content if needed. 

 

 

 
You can add a button to the Internet Explorer toolbar for creating mobile 
favorites. In Internet Explorer on your desktop PC, on the View menu, click 
Toolbars, and then click Customize.  

Conserving Memory 
Mobile favorites take up storage memory on your hp Jornada. Follow these 
tips to minimize the amount of memory used: 

• Use ActiveSync settings to turn off pictures and sounds for the Mobile 
Favorites information type or to stop some mobile favorites from being 
downloaded to your hp Jornada. For more information, see 
ActiveSync Help. 
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• Limit the number of downloaded linked pages. In Internet Explorer on 
the desktop PC, right-click the mobile favorite you want to change, 
and then click Properties. On the Download tab, specify 0 or 1 
for the number of linked pages you want to download. 

Using AvantGo Channels 
AvantGo is a free interactive service that gives you access to personalized 
content and thousands of popular Web sites. You subscribe to AvantGo 
channels directly from your hp Jornada. Then you synchronize your hp 
Jornada with your desktop PC or connect to the Internet to download the 
content. For more information, visit the AvantGo Web site. 

To sign up for AvantGo  

1. In ActiveSync options on the desktop PC, turn on synchronization 
for the AvantGo information type. 

2. In Pocket Internet Explorer on your hp Jornada, tap the Favorites 
button to display your list of favorites. 

3. Tap the AvantGo Channels link. 
4. Tap the Activate button. 
5. Follow the directions on the screen. You will need to synchronize 

your hp Jornada with your desktop PC, and then tap the My 
Channels button to complete the AvantGo setup. 

 
When synchronization is complete, tap the AvantGo Channels link in your 
list of favorites to see a few of the most popular channels. To add or 
remove channels, tap the Add or Remove link. 

Sending and Receiving E-mail 
If you have an e-mail account with an ISP or on a corporate network, you 
can use Inbox to send and receive e-mail messages in two ways:  

• Synchronize e-mail messages with Microsoft Exchange or Microsoft 
Outlook on your desktop PC.  

• Send and receive e-mail messages by connecting directly to an e-mail 
server through an ISP or a network. 
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Synchronizing E-mail Messages 
You can synchronize e-mail messages as part of the general 
synchronization process whenever you connect your hp Jornada to your 
desktop PC. First, you must enable Inbox synchronization in ActiveSync. 
For information on enabling Inbox synchronization, see ActiveSync Help 
on the desktop PC.  

During synchronization, the following occurs: 

• Messages are copied from the mail folders of Exchange or Outlook on 
your desktop PC to the ActiveSync folder in Inbox on your hp Jornada. 
By default, you will receive messages from the past 3 days only, the 
first 100 lines of each message, and file attachments of less than 100 
KB in size. 

• E-mail messages in the Outbox folder on your hp Jornada are 
transferred to Exchange or Outlook, and then sent from those 
programs. 

• E-mail messages in subfolders must be selected in ActiveSync on your 
desktop PC in order to be transferred. 

 

Connecting Directly to an E-mail Server 
In addition to synchronizing e-mail messages with your desktop PC, you 
can send and receive e-mail messages by using a modem or network 
connection and Inbox on your hp Jornada.  

In addition to the creating a connection to a network or an ISP, you must 
set up an e-mail “service” in Inbox.  
 

 The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP 
gateway.  
 

To set up an e-mail service 

• In Inbox, tap Services, and then tap New Service. Follow the 
directions in the New Service Wizard. 

 
You can use multiple e-mail services to receive your messages. For each e-
mail service you intend to use, first set up and name the e-mail service. If 
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you use the same service to connect to different mailboxes, set up a 
separate service for each mailbox. 

To connect to an e-mail service 

• In Inbox, tap Services, and then tap Connect. 
 
When you connect to the e-mail server, new messages are downloaded to 
the Inbox folder on your hp Jornada, messages in the Outbox folder are 
sent, and messages that have been deleted on the e-mail server are 
removed from the Inbox folder on your hp Jornada. 

Messages that you receive directly from an e-mail server are linked to your 
e-mail server rather than your desktop PC. When you delete a message on 
your hp Jornada, it is also deleted from the e-mail server the next time you 
connect based on the settings you selected in ActiveSync.  

You can work online or offline. When working online, you read and 
respond to messages while connected to the e-mail server. Messages are 
sent as soon as you tap Send, which saves space on your hp Jornada. 

When working offline, you should download new message headers or 
partial messages, and then you can disconnect from the e-mail server while 
you decide which messages to download completely. The next time you 
connect, Inbox downloads any messages you marked for retrieval and 
sends the messages in your Outbox folder. 
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Using the Message List 
Messages you receive are displayed in the message list. By default, the 
most recently received messages are displayed first in the list. 

Select the sort order
for messages.

Select the service and folder
you want to display.

Tap to connect to
the selected service.

Tap to connect and to
send and receive e-mail.

Tap to open a message.

Tap and hold to display
a pop-up menu of actions.

 

When you receive a message, tap it to open it. Unread messages are 
displayed in bold. 
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Tap to delete this message.

Tap to view  the previous
or next message.

Tap to reply to or
forward this message.

Tap to return to
the message list.

 

When you connect to your e-mail server or synchronize with your desktop 
computer, by default, you will receive messages from the last five days 
only, the first 100 lines of each new message, and file attachments of less 
than 100 KB in size. The original messages remain on the e-mail server or 
your desktop PC. 

You can mark the messages that you want to retrieve in full during your 
next synchronization or e-mail server connection. In the message list, tap 
and hold the message you want to retrieve. On the pop-up menu, tap 
Mark for Download. The icons in the Inbox message list give you 
visual indications of message status. 
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You specify your downloading preferences when you set up the service or 
select your synchronization options. You can change them at any time: 

• Change options for Inbox synchronization using ActiveSync options. 
For more information, see ActiveSync Help.  

• Change options for direct e-mail server connections in Inbox on your 
hp Jornada. Tap Tools, and then tap Options. On the Service tab, 
tap the service you want to change. To remove a service, tap and hold 
the service, and then tap Delete. 

Composing Messages 
To compose a message 

1. Tap New.  
2. In the To field, enter an e-mail address of one or more recipients, 

separating them with a semicolon, or select a name from the 
contact list by tapping the Address Book button.  
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Tap to show or hide
the complete header.

Tap to send the message.

Tap to insert common messages.

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.

 

3. Compose your message. To enter preset or frequently used 
messages, tap My Text and select a message. 

4. When you have finished the message, tap Send. 
 
The message is placed in the Outbox folder on your hp Jornada and will 
be delivered in one of two ways: 

• The message is transferred to the Outbox folder in Exchange or 
Outlook on your desktop PC, and sent the next time you synchronize. 

• The message is transferred to your e-mail server the next time you 
connect. In Inbox, make sure the appropriate service is selected on the 
Services menu. Then tap the Connect button (or tap Connect on 
the Services menu). 
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Managing E-mail Messages and Folders 
By default, messages are displayed in one of five folders for each service 
you have created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items. 
The Deleted Items folder contains messages that have been deleted on your 
hp Jornada. The behavior of the Deleted and Sent Items folders depends 
on the options you have chosen. In the message list, tap Tools, and then 
tap Options. On the Message tab, select your options. 

You can organize messages into additional folders. To create new folders, 
tap Tools, and then tap Manage Folders. To move a message to 
another folder, in the message list, tap and hold the message, and then 
tap Move to on the pop-up menu.  

Folder Behavior with a Direct Connection to an E-mail Server 
The behavior of the folders you create depends on whether you are using 
ActiveSync, POP3, or IMAP4: 

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook 
will automatically be synchronized with your hp Jornada. You can 
select to synchronize additional folders by designating them for 
ActiveSync. The folders you create and the messages you move will 
then be mirrored on the server. For example, if you move two 
messages from the Inbox folder to a folder named Family, and you 
have designated Family for synchronization, the server creates a copy 
of the Family folder and copies the messages into that folder. You can 
then read the messages while away from your desktop computer. 

• If you use POP3 and you move e-mail messages to a folder you 
created, the link is broken between the messages on the device and 
their copies on the mail server. The next time you connect, the mail 
server will see that the messages are missing from the device Inbox 
and delete them from the server. This prevents you from having 
duplicate copies of a message, but it also means that you will no 
longer have access to messages that you move to folders created from 
anywhere except the device.  
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• If you use IMAP4, the folders you create and the e-mail messages you 
move are mirrored on the server. Therefore, messages are available to 
you any time you connect to your mail server, whether it is from your 
device or desktop computer. This synchronization of folders occurs 
whenever you connect to your mail server, create new folders, or 
rename/delete folders when connected. 
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6 | Configuring and Optimizing 
Your hp Jornada 

This chapter details ways you can optimize your hp Jornada using the 
Settings and the hp settings application, and describes ways you can 
expand features and functionality by adding programs. This chapter also 
offers important tips on safeguarding your data by managing power and 
memory and using the security settings. In this chapter, you will learn to 

• Manage power effectively. 
• Manage the memory on your hp Jornada. 
• Adjust settings for the display and sounds. 
• Use security features to protect your data. 
• Configure hardware buttons.  
• Configure menus for easy access to programs and documents. 
• Add or remove programs. 
• Add functionality to your hp Jornada with CompactFlash cards and 

optional accessories. 
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Managing Power  
Because the data and files you save on your hp Jornada are stored in 
RAM, maintaining a continuous power supply to the hp Jornada at all 
times is extremely important. If your hp Jornada runs out of power, all 
information stored in RAM is lost. Although Microsoft Windows for Pocket 
PC and the preinstalled programs will not be erased, any information you 
have entered, programs you have added, and custom settings are erased 
if you lose power.  
 

 

Data stored in the hp safe store folder or on a CompactFlash card will be 
saved, even if your hp Jornada loses power. To protect your data, use hp 
backup to back up regularly to the hp safe store folder or to a CompactFlash 
card. 

 

 
How long you can operate your hp Jornada without recharging the battery 
depends on the features and functions you use most. Under typical usage 
conditions, the battery included with your hp Jornada will provide 
approximately 14 hours of use (without the backlight). Note that some 
functions, such as listening to music or using CompactFlash cards, use 
considerable power and may reduce this time significantly.  

When your hp Jornada displays a dialog box warning of low power, you 
should respond as soon as possible by recharging the main battery or 
replacing the backup battery. If you continue to use your hp Jornada until 
power reaches a critical low condition, a “Battery very low” message 
appears, and the hp Jornada shuts down automatically. You will be unable 
to use your hp Jornada until you connect to external power for charging. 
The backup battery does not provide enough power to operate your hp 
Jornada; it is intended only to preserve your data for a short time until you 
can recharge the main battery. 

Because the main battery is charged automatically whenever your hp 
Jornada is connected to ac power, simply connect the ac power adapter 
or place your hp Jornada in the USB cradle to recharge it when the power 
is low. While your hp Jornada is connected to ac power, the notification 
button/LED indicates the charging status:  

• Amber indicates that the battery is charging (connected to ac power).  
• Green indicates that the battery is fully charged.  
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To check the remaining power 

1. On the Start menu, tap Settings.  
2. On the System tab, tap the Power icon.  

The remaining power is displayed on a status bar in the Power 
control panel.  

 

 
Under certain conditions, the Power Status icon is displayed on the Command 
bar in the Today screen. Simply tap the Power Status icon to open the Power 
control panel.  

 

Power Tips 
Follow these tips to ensure the longest use of your hp Jornada between 
charges: 

• Turn off the backlight.   Press and hold the power button to turn 
off the backlight, or use the Backlight control panel to set the backlight 
to turn off automatically after a short period of inactivity. 

• Turn off the display manually.   If you are playing music or 
using other functions that do not require the display, turn off the 
display by pressing and holding the notification button/LED.  (Turn on 
the display by pressing and holding the notification button/LED 
again.)  

• Suspend frequently.   Use the Power control panel to shorten the 
length of continuous idle time before your hp Jornada auto-suspends. 
Press the power button to turn off your hp Jornada when it is not in 
use, even for a short time. 

• Always use ac power when connecting your hp Jornada 
to your desktop PC.   Note that your hp Jornada will not auto-
suspend while it is connected. 

• Turn off sounds.   Use the hp settings application to mute the 
speaker, or use the Sounds & Notifications control panel to turn off all 
but the most necessary system sounds.  
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• Avoid using CompactFlash card accessories while on 
battery power.   Some CompactFlash cards use considerable 
power and will quickly drain your battery.  

• Do not “listen” for infrared transfers.   Although you can set 
your hp Jornada to constantly monitor the infrared port for files sent 
from other devices, doing so will quickly drain your batteries. 

 

 

Use the ac adapter to plug your hp Jornada into external power whenever 
possible, especially when connecting to a desktop PC or when using a 
CompactFlash card modem, NIC, or other peripheral device. Do not let the 
notification button/LED flash for a long time. 

 

 

Managing Memory 
Your hp Jornada uses three kinds of memory: the hp safe store folder, 
storage and program memory (RAM), and optional CompactFlash memory 
cards.  

The hp safe store folder 
The hp safe store folder uses nonvolatile memory; that is, it will not be 
erased if your hp Jornada loses power. The hp safe store folder contains 
several preinstalled programs, as well as available storage space that you 
can use to store your most important files or as a location for your backup 
file.  

The hp safe store folder appears under the My Device folder on your hp 
Jornada. Files stored in the hp safe store folder are not included when you 
back up your files using ActiveSync or the hp backup application.  

For more information on backing up your hp Jornada to the hp safe store 
folder, see “Backing Up and Restoring Data” in chapter 6.  

Storage and Program Memory 
The volatile RAM memory on your hp Jornada is allocated between 
storage memory and program memory. The operating system automatically 
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manages the allocation between storage and program memory; however, 
in some situations—such as when memory is low—it may not be able to 
adjust the memory properly. If you receive a message stating that storage 
or program memory is unavailable, try the following solutions. 

To increase storage memory, you can 

• Move files or programs into the hp safe store folder. Files in the hp 
safe store folder do not use RAM-based storage memory. 

• Buy an optional CompactFlash Type I or Type I extended memory 
card, and move files from internal memory to the card. (For more 
information on using CompactFlash cards, see “Accessories,” later in 
this chapter.)  

• Delete unnecessary files. 
• Remove Web pages stored for offline viewing in Internet Explorer 

folders. 
• Remove programs you no longer use. See “Adding or Removing 

Programs,” later in this chapter. 
• Clear program memory. See the section below. 
 
To increase program memory, you can 

• Use hp task switcher or the Memory control panel to stop programs 
you are not currently using. In most cases, programs automatically 
stop to free needed memory. However, in some situations, such as 
when a dialog box is waiting for a response, the program may not be 
able to stop automatically. 

• Clear storage memory as described above. This will free some storage 
memory so that it can be reallocated as program memory. 

• Remove your hp Jornada from the cradle, remove the CompactFlash 
card (if installed), and reset your hp Jornada. See “Resetting Your hp 
Jornada” in chapter 9.  

To use the Memory control panel to stop programs  

1. Open the Memory control panel, and then tap the Running 
Programs tab to check the state of your active programs. 

2. To stop a running program, select the program in the list, and 
then tap Stop. 
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To use hp task switcher to stop programs  

1. Press and hold the Tasks hot key to display hp task switcher. 
2. Tap the Close button 

–or– 
On the pop-up menu, tap Close Window, and then tap a 
program in the list or tap Close All. 

 

CompactFlash Memory Cards 
CompactFlash memory cards are small, removable flash storage cards that 
enable you to expand the memory of your hp Jornada. You can use 
CompactFlash memory cards for backup storage, archives, or to transfer 
large files to other devices. CompactFlash cards can be purchased from a 
variety of third-party vendors. 

Your hp Jornada supports CompactFlash Type I or Type I extended cards. 
In addition to CompactFlash memory cards, you can buy cards that offer 
additional functionality, such as modems, NICs, cameras, and other 
peripheral devices. For more information, see “Accessories” later in this 
chapter.  

Backing Up and Restoring Data 
To prevent loss of data, you should back up your hp Jornada frequently. 
Your hp Jornada comes with three programs for backing up data: 

• Microsoft ActiveSync.   ActiveSync enables you to back up data to 
your desktop PC. You can back up all data on your hp Jornada, or 
only your PIM databases (Calendar, Contacts, and Tasks). You can set 
ActiveSync to back up automatically each time you connect, or you 
can back up manually, whenever you choose. For more information, 
see ActiveSync Help on your desktop PC. 

• hp backup.   The hp backup application enables you to back up all 
data on your hp Jornada, or only your PIM databases and/or e-mail 
messages. You can save the backup file in the hp safe store folder or 
on an optional, removable CompactFlash memory card.   
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• hp emergency backup.   When you activate hp emergency 
backup, your PIM databases are automatically backed up to the hp 
safe store folder. The backup file is password-protected. After you 
restore your hp Jornada to the factory default settings, you are 
prompted to enter the password and restore the databases.   

Using hp backup 
The hp backup application gives you added flexibility in backing up your 
valuable data. With hp backup, you can back up all data or back up only 
your Calendar, Contacts, Tasks, and Inbox databases. You can save the 
backup file to the hp safe store folder or to an optional CompactFlash 
memory card, so you can safeguard your data even while you are 
traveling or away from your desktop PC.  
 

 

You can back up data to internal (RAM) memory on your hp Jornada; however, 
if you restore your hp Jornada to the factory default settings or accidentally lose 
power, the back up file will be erased. To ensure the safety of your data, it is 
recommended that you back up to the hp safe store folder, to a CompactFlash 
memory card, or to your desktop PC. 

 

 

To back up data using hp backup 

1. Use hp task switcher to close all running applications.  
2. Disconnect your hp Jornada from your desktop PC.  
3. On the Start menu on your hp Jornada, tap Programs. 
4. In the hp Applications folder, tap the hp backup icon. 
5. On the Backup tab, select Back up all files or Back up 

only databases. 
6. If you want to password-protect your backup file, tap Backup 

Options, and enter a password using the Input panel. 
7. Tap Back Up Now. 
8. In the Name box, enter a name for the backup file, and select a 

storage location from the drop-down list.  
9. Tap OK. 
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Restoring Data 
When you use the backup file to restore information, information on your 
hp Jornada is replaced with the information stored in the backup file. If 
you have created files on your hp Jornada since the last backup and do 
not want to delete these files during the restore process, move the files from 
your hp Jornada to your desktop PC—or to an optional CompactFlash 
memory card—before restoring information.  
 

 

Depending on the type of backup file, the restore operation replaces all 
information stored in your PIM databases or all data stored on your hp Jornada. 
Any data added after the backup file was created will be lost.  

 

 

To restore PIM databases with hp backup 

1. Use hp task switcher to close all running applications. (Press and 
hold the hp home menu hot key to display the hp task switcher 
pop-up menu, and then tap the Close All button.) 

2. Disconnect your hp Jornada from your desktop PC. 
3. On the Start menu on your hp Jornada, tap Programs. 
4. In the hp Applications folder, tap the hp backup icon. 
5. On the Restore tab, select Restore only databases, and 

then tap Restore Now. 
6. In the file list, tap the name of a backup file you want to restore. 
7. Remove the CompactFlash card (if installed), and reset your hp 

Jornada. See “Resetting Your hp Jornada” in chapter 9.  
 

To restore all data with hp backup 

1. Disconnect your hp Jornada from ac power, and remove both the 
main and backup batteries. Wait 5 minutes. 

2. Replace the main battery, and then replace the backup battery. 
3. Complete the Welcome Wizard.  
4. On the Start menu on your hp Jornada, tap Programs. 
5. In the hp Applications folder, tap the hp backup icon. 
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6. On the Restore tab, select Restore all files, and then tap 
Restore Now. 

7. In the file list, tap the name of a backup file you want to restore. 
8. Remove the CompactFlash card (if installed), and reset your hp 

Jornada. See “Resetting Your hp Jornada” in chapter 9.  
 

 

When you restore data, your hp Jornada must have the same regional settings 
that it had when you completed the backup; otherwise, you will not be able to 
restore the files. To change regional settings, on the Start menu, tap Settings, 
and then tap the Regional Settings icon on the System tab. Select your 
region from the drop-down list. 

 

 

Using hp emergency backup 
When you enable hp emergency backup, your PIM databases and/or e-
mail messages are automatically saved to the hp safe store folder. The 
backup file is protected even if your hp Jornada loses power or if you reset 
the factory defaults. You do not need to carry a removable storage card or 
connect to your desktop PC to back up and restore the file.  

For hp emergency backup to function, you must ensure that there is enough 
free memory in the hp safe store folder to save your backup file. If you 
save other files and programs in the hp safe store folder, you may not 
have enough room for your backup file.  

To back up data using hp emergency backup 

1. On the Start menu, tap Settings. 
2. On the System tab, tap the hp emergency backup icon. 
3. Select the Enable emergency backup check box. 
4. Enter a password for the backup file. You must enter a password. 
5. Select the check boxes for the databases you want to back up. 
6. Tap OK. 

 
The databases you selected will be backed up automatically each time you 
make changes. While hp emergency backup is activated, the hp backup 
icon is displayed in the Command bar. 
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Restoring Data 
The hp emergency backup application gives you the option of restoring 
data automatically whenever you restore your hp Jornada to the factory 
default settings. After you complete the Welcome Wizard, you will be 
asked if you want to restore your databases and then prompted to enter 
your password. For more information, see “Restoring Factory Defaults” in 
chapter 9. 

Adjusting Settings 
Use the hp settings application to quickly change settings or set options for 
the display, alerts and notifications, and power management.  

To start hp settings  

• On the Start menu, tap hp settings. 
 

 

You can use pop-up menus to quickly change your display profiles and volume 
profiles. Press and hold the Contacts hot key to display the volume profile 
pop-up menu. Press and hold the Calendar hot key to display the display 
profile pop-up menu.  

 

 

Display Settings 
The screen of your hp Jornada uses ambient light to enhance the display. 
That is, the brighter the surrounding light, the better you will be able to see 
the screen. If you are in a dark room, you can use the backlight to 
compensate for the low ambient light. 

Your hp Jornada includes a light sensor. You can set an option to turn on 
the backlight automatically whenever the light sensor detects that 
conditions are too dim to see the screen clearly. Use display settings to 
adjust the brightness of your hp Jornada screen, and set options for turning 
the backlight on and off.  
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You can also create display profiles for different environments or lighting 
conditions (for example, indoors or low power). Display profiles remember 
all of the display options for brightness and backlight.  

The display settings are shown by default when you start hp settings.  
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 To quickly change display profiles, press and hold the Calendar hot key, and 
then select a profile from the pop-up menu.   
 

Volume Settings 
Volume settings control the volume and tone of the alarms and notification 
sounds played by your hp Jornada. You can create volume profiles for 
different environments, for example a Loud profile for noisy environments, 
or a Meeting profile that silences most alerts.  
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To quickly change between volume profiles, press and hold the Contacts hot 
key, and then select a profile from the pop-up menu.   

Power Preferences Settings 
Use the Power Preferences page of the hp settings application to set 
options for turning your hp Jornada on and off, both for convenience and 
to conserve battery power. You can set your hp Jornada to turn on 
whenever you tap the touch screen. Disabling the record button and the hp 
hot keys while the hp Jornada is off prevents you from inadvertently turning 
on your hp Jornada by pressing one of these buttons.  
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Adjusting Other Settings 
You can change many settings on your hp Jornada to suit the way you 
work. To see the available options, tap Settings on the Start menu, and 
then tap any of the icons on the Personal or System tabs. In particular, 
you might want to adjust the following: 

• Clock.   Change the time or set alarms.  
• Owner Information.   Enter the contact information you want to be 

displayed each time you turn on your hp Jornada.  
• Password.   Limit access to your hp Jornada by requiring a four-digit 

password to be entered each time you turn on your hp Jornada.  
• Today.   Customize the look of, and the information that is displayed 

on, the Today screen.  
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Configuring Hardware Buttons 
You can configure the hardware buttons on your hp Jornada to suit the 
way you work. Use the Buttons control panel to assign the hp hot keys and 
the record button to start any program.  

To assign a program to a hardware button 

1. On the Start menu, tap Settings, and then tap the Buttons icon. 
2. On the Program Buttons tab, select a button from the list. 
3. In the Button assignment list, select the program you want to 

assign to the button.  

To control the scroll speed  

1. On the Start menu, tap Settings, and then tap the Buttons icon. 
2. On the Up/Down Control tab, move the sliders to set the 

repeat rate and the delay before repeat. 

Configuring Menus 
You can customize the menus on your hp Jornada to ensure you have easy 
access to programs or documents. 

hp Home Menu 
Use the hp home menu application to quickly launch your favorite 
programs or open frequently used documents. You can modify the buttons 
on the hp home menu by adding descriptions or by assigning them to 
other programs. You can also add pages that contain buttons for the 
programs or documents you use most. 
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To modify a button assignment 

1. Press the hp home menu hot key to open hp home menu.   
2. Select the page you want to modify from the drop-down list of 

home menu pages. 
3. Tap and hold the stylus on the button you want to modify. 
4. On the pop-up menu, tap Assign, Rename, or Delete.  

• Tap Assign, and then browse to select the program or 
document you want to assign to the button. 

• Tap Rename, and then type a description to be displayed 
under the button. The description can be up to 10 characters 
long. The default description is the file name. 

• Tap Delete to clear the current button assignment. 
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To add a page to the hp home menu 

1. Press the hp home menu hot key to open the hp home menu. 
2. On the Page menu, tap Add Page. 
3. Enter a name for the page, and then tap OK. 
4. On the new page, tap and hold a button to assign to a program 

or document. 
5. On the pop-up menu, tap Assign, and then browse to select the 

program or document you want to assign to the button. 
 

Start Menu  
You can add programs to the Start menu to make it easier to access the 
programs you use most.  

To add a program to the Start menu 

1. On the Start menu, tap Settings, and then tap Menus. 
2. On the Start Menu tab, select the check box for the program 

you want to add. 
 
The Start Menu tab displays only the programs stored in the Start Menu 
folder on your hp Jornada. If you do not see a particular program listed, 
use File Explorer to move the program to the Start Menu folder. 

Adding or Removing Programs 

Adding Programs 
You can add even more functionality to your hp Jornada by installing 
additional software and programs. A wide variety of software is available 
for Windows Powered Pocket PCs, ranging from custom business 
applications and system utilities to games and entertainment. Some 
programs are available on the Pocket PC Companion CD included with 
your hp Jornada. Other programs are available from software vendors or 
on the Web.  
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Install only programs designed specifically to run on an hp Jornada personal 
digital assistant and/or a Windows Powered Pocket PC. You cannot run 
programs designed for Windows on your hp Jornada. In addition, you may 
need a version of the program designed specifically for the StrongARM 
processor used by your hp Jornada. 

 

 
Install software to your hp Jornada by first loading the installation files onto 
your desktop PC, and then using ActiveSync or running the Application 
Manager. You can install programs to storage memory (RAM) or to the hp 
safe store folder. 

To install a program using ActiveSync 

1. Download the program to your desktop computer (or insert the CD 
or disk that contains the program into your desktop computer). 
You may see a single *.exe or *.xip file, a *.zip file, a Setup.exe 
file, or several versions of files for different device types and 
processors. Be sure to select the program designed for the Pocket 
PC and the StrongARM processor. 

2. Connect your hp Jornada to your desktop PC. 
3. If the program includes an installer program (typically named 

Setup.exe or Install.exe), double-click the installer program on the 
desktop PC. The installer program copies the necessary files to 
your hp Jornada. 
–or– 
If the program does not include an installer, use ActiveSync 
Explore to copy the program file to the Program Files folder on 
your hp Jornada. Refer to the Read Me file or documentation that 
came with the program to be sure you have copied the necessary 
file(s). For more information on copying files using ActiveSync, see 
ActiveSync Help. 

 

 

You can also use Pocket Internet Explorer to download some programs from the 
Internet directly to your hp Jornada. If the program includes a *.xip, *.exe or 
*.zip file, a Setup.exe file, or a cabinet (*.cab) file for Pocket PC, you can 
download this file to your hp Jornada, and then tap the icon to install the 
program. 
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Removing Programs 
To free storage memory on your hp Jornada, you can remove programs 
you no longer use. Only programs that are stored in RAM or in the hp safe 
store folder can be removed. Programs preinstalled programs in Flash 
ROM cannot be removed; however, these programs do not use storage 
memory. 

To remove a program 

1. On the Start menu, tap Settings.  
2. On the System tab, tap Remove Programs. 
3. Select the program in the list, and then tap Remove.  

 

 

If the program does not appear in the list of installed programs, use File 
Explorer on your hp Jornada to locate the program, tap and hold the program, 
and then tap Delete on the pop-up menu. 

 

 

Accessories 
By purchasing accessories for your hp Jornada, you can add functionality, 
replace lost parts, and protect your hp Jornada from accidental damage. 
Hewlett-Packard makes a variety of accessories designed specifically to 
enhance your hp Jornada. In addition, you can purchase CompactFlash 
card accessories from many vendors. 

hp Accessories 
Many optional accessories are available from Hewlett-Packard. The 
Accessories Guide included with your hp Jornada includes a catalog of 
accessories designed to work with the hp Jornada 560 series personal 
digital assistant. Check the Hewlett-Packard Web site at 
www.hp.com/jornada for updates to this list.  
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CompactFlash Cards 
CompactFlash cards provide a wide range of additional functionality, such 
as additional memory, removable storage, connection to an external 
monitor, connection to a network, and modems. Many cards have been 
tested specifically for use with the hp Jornada. For a list of recommended 
cards, visit the hp Web site at www.hp.com/jornada. 

In addition to CompactFlash memory cards, you can buy cards that offer 
additional functionality, such as modems, NICs, cameras, and other 
peripheral devices. Your hp Jornada supports CompactFlash Type I and 
Type I extended cards. 

Before you can use a particular card, you must have a driver for that card. 
Your hp Jornada includes drivers for many popular cards, and others are 
included on the Pocket PC Companion CD. If you cannot find a driver for 
your card on the CD, the software drivers for the Microsoft Windows for 
Pocket PC operating system should be available from the card’s 
manufacturer. Install software drivers as you would install any other 
software or program. For more information, see “Adding or Removing 
Programs,” earlier in this chapter. 

To install a CompactFlash card 

1. Remove the dummy card from the CompactFlash card slot. 
2. If the card is a Type I extended card, remove the CompactFlash 

door. 
3. Align the card as shown in the diagram, and push it into the slot 

until it clicks into place. 
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If the card is Type I extended, remove the door from the CompactFlash Type I
extended card slot, as shown on the left.
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7 | Microsoft Pocket Outlook 

Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and 
Notes. You can use these programs individually or together. For example, 
e-mail addresses stored in Contacts can be used to address e-mail 
messages in Inbox.  

Using ActiveSync, you can synchronize information in Microsoft Outlook 
or Microsoft Exchange on your desktop PC with information in Pocket 
Outlook on your hp Jornada. Each time you synchronize, ActiveSync 
compares the changes you made on your hp Jornada and desktop PC and 
updates both computers with the latest information. For information on 
using ActiveSync, see ActiveSync Help on your desktop PC. 

In this chapter, you will learn to 

• Schedule appointments and meetings using Calendar. 
• Keep track of friends and colleagues using Contacts. 
• Keep a to-do list in Tasks. 
• Capture thoughts and ideas with Notes. 
 
For details on using Inbox to send and receive e-mail messages, see 
“Sending and Receiving E-mail” in chapter 5.  
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Calendar: Scheduling Appointments and 
Meetings 
Use Calendar to schedule appointments, including meetings and other 
events. You can check your appointments in one of several views (Agenda, 
Day, Week, Month, and Year) and easily switch views by using the View 
menu. 

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.  

 

 
You can customize the Calendar display (for example, change the first day of 
the week), by tapping Options on the Tools menu. 
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To create an appointment 

1. In Day or Week view, tap the desired date and time for the 
appointment. 

2. Tap New. 

Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.

 
3. Using the Input panel, tap first to select the field, and then enter a 

description and a location.  
4. If needed, tap the date and time to change them. 
5. Enter other desired information. You will need to hide the Input 

panel to see all available fields. 
6. To add notes, tap the Notes tab. You can enter text, draw, or 

create a recording. For more information on creating notes, see 
“Notes: Capturing Thoughts and Ideas,” later in this chapter. 

7. Tap OK to return to Calendar.  
 

 If you select Remind me in an appointment, your hp Jornada will remind you 
according to the options set in the Sounds & Notifications control panel.  
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Using the Summary Screen 
When you tap an appointment in Calendar, a summary screen is 
displayed. To change the appointment, tap Edit. 

View appointment details.

View.

Tap to change
appointment.

Creating Meeting Requests 
You can use Calendar to set up meetings with users of Outlook or Pocket 
Outlook. The meeting notice will be created automatically and sent either 
when you synchronize Inbox or when you connect to your e-mail server. 
Indicate how you want meeting requests sent by tapping Tools and then 
Options. If you send and receive e-mail messages through ActiveSync, 
select ActiveSync.  

To schedule a meeting 

1. Create an appointment. 
2. In the appointment details, hide the Input panel, and then tap 

Attendees. 
3. From the list of e-mail addresses in Contacts, select the meeting 

attendees.  
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The meeting notice is created automatically and placed in the Outbox 
folder. 

For more information on sending and receiving meeting requests, see 
Calendar Help and Inbox Help on your hp Jornada. 

Contacts: Tracking Friends and Colleagues 
Contacts maintains a list of your friends and colleagues so that you can 
easily find the information you are looking for, whether you are at home or 
on the road. Using the hp Jornada infrared port, you can quickly share 
Contacts information with users of Pocket PCs and other mobile devices.  

Tap and enter part of a name to
quickly find it in the list.

Tap to display or edit
the contact details.

Tap and hold to display
a pop-up menu of actions.

Tap to see additional phone
numbers and e-mail addresses.

Tap to create a new contact.

Select the category of contacts
you want displayed in the list.
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To change the way information is displayed in the list, tap Tools, and then tap 
Options. 

 

 

To create a contact 

1. Tap New. 

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.

 
2. Using the Input panel, enter a name and other contact 

information. You will need to scroll down to see all available 
fields. 
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3. To assign the contact to a category, scroll to and tap Categories 
and select a category from the list. In the contact list, you can 
display contacts by category. 

4. To add notes, tap the Notes tab. You can enter text, draw, or 
create a recording. For more information on creating notes, see 
“Notes: Capturing Thoughts and Ideas,” later in this chapter. 

5. Tap OK to return to the contact list. 

Finding a Contact 
There are four ways to find a contact:  

• On the Start menu, tap Find, enter the contact name, select 
Contacts for the type, and then tap Go.  

• In the contact list, enter a contact name in the box under the 
Navigation bar. To show all contacts again, clear text from the box or 
tap the button to the right of the box.  

• In the contact list, tap the category list (labeled All Contacts by 
default) and select the type of contact that you want displayed. To 
show all contacts again, select All Contacts. To view a contact not 
assigned to a category, select None.   

• To view the names of companies your contacts work for, in the contact 
list, tap View, and then tap By Company. The number of contacts 
that work for that company will be displayed to the right of the 
company name.  
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Using the Summary Screen 
When you tap a contact in the contact list, a summary screen is displayed. 
To change the contact information, tap Edit. 

 

View contact details.

Tap to view notes.

Tap to change contact information.
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Tasks: Keeping a To-Do List 
Use Tasks to keep track of what you have to do.  

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

 

 

 To change the way information is displayed in the list, tap Tools, and then tap 
Options.  
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To create a task 

1. Tap New. 

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

 
2. Using the Input panel, enter a description. 
3. You can enter a start date and due date or enter other information 

by first tapping the field. If the Input panel is open, you will need 
to hide it to see all available fields. 

4. To assign the task to a category, tap Categories and select a 
category from the list. In the task list, you can display tasks by 
category. 

5. To add notes, tap the Notes tab. You can enter text, draw, or 
create a recording. For more information on creating notes, see 
“Notes: Capturing Thoughts and Ideas,” later in this chapter. 
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6. Tap OK to return to the task list. 
 

 To quickly create a task with only a subject, tap Entry Bar on the Tools menu, 
and then tap Tap here to add a new task. Enter your task information.  
 

Using the Summary Screen 
When you tap a task in the task list, a summary screen is displayed. To 
change the task, tap Edit.  

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.
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Notes: Capturing Thoughts and Ideas 
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers 
with Notes. You can create a written note or a recording. You can also 
include a recording in a note. If a note is open when you create the 
recording, it will be included in the note as an icon. If the note list is 
displayed, it will be created as a stand-alone recording. 

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.

To create a note 

1. Tap New. 
2. Create your note by writing, drawing, typing, or recording. For 

more information about using the Input panel, writing and 
drawing on the screen, and creating recordings, see “Entering 
Information” in chapter 3. 
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8 | Companion Programs 

Your hp Jornada includes Microsoft Pocket PC Software 2002, as well as 
programs from other vendors. The software includes hp image viewer, 
Microsoft Pocket Word, Microsoft Pocket Excel, Windows Media Player 
for Pocket PC, and Microsoft Reader. Third-party programs include 
OmniSolve from Landware and CodeWallet Pro from Developer One. This 
section provides an overview of these programs and enough information to 
get you started. For complete instructions on using a program, refer to 
online Help for that program.  

In this chapter, you will learn about 

• Microsoft Pocket Word 
• Microsoft Pocket Excel 
• Microsoft Windows Media Player for Pocket PC 
• Microsoft Reader 
• MSN Messenger 
• hp image viewer 
• Landware OmniSolve financial calculator 
• CodeWallet Pro from Developer One1 

1 CodeWallet Pro is not available on all hp Jornada 560 series models.  
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Microsoft Pocket Word 
Microsoft Pocket Word works with Microsoft Word on your desktop PC to 
give you easy access to copies of your documents. You can create new 
documents on your hp Jornada, or you can copy documents from your 
desktop PC. Synchronize documents between your desktop PC and your 
hp Jornada regularly so that you have the most up-to-date content in both 
locations.  

To use Pocket Word 

1. On the Start menu, tap Programs, and then tap the Pocket 
Word icon. 

2. Tap the name of a document in the file list. 
–or– 
Tap New to open a blank document.  

 

 

To open a template rather than a blank document, select a template for new 
documents. On the Tools menu, tap Options, and then browse to select the 
default template. When you tap New, the template appears with appropriate 
text and formatting already provided. 

 

 
You can open only one document at a time; when you open a second 
document, you will be asked to save the first. You can save a document 
you create or edit in a variety of formats, including Pocket Word (.psw), 
Rich Text Format (.rtf), and Plain Text (.txt). 

You can enter information in Pocket Word in four modes: writing, 
drawing, typing, and recording. Use the View menu to switch between 
modes. Each mode has its own toolbar, which you can show and hide by 
tapping the Show/Hide Toolbar button on the Command bar. 

• Typing Mode.   Use the Input panel to enter typed text into the 
document with either the soft keyboard or the Character Recognizer. 
For more information on entering typed text, see “Entering 
Information” in chapter 3. 
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• Writing Mode.   In writing mode, use your stylus to write directly on 
the screen. Ruled lines are displayed as a guide, and the zoom 
magnification is greater than in typing mode to allow you to write 
more easily. For more information on writing and selecting writing, 
see “Entering Information” in chapter 3. 

 

 Written words are converted to graphics (metafiles) when a Pocket Word 
document is converted to a Word document on your desktop PC.  
 
• Drawing mode.   In drawing mode, use your stylus to draw on the 

screen. Gridlines appear as a guide. When you lift your stylus off the 
screen after the first stroke, you will see a drawing box indicating the 
boundaries of the drawing. Every subsequent stroke within or touching 
the drawing box becomes part of the drawing. For more information 
on drawing and selecting drawings, see “Entering Information” in 
chapter3. 

• Recording mode.   Use recording mode to embed a recording into 
your document. Recordings are saved as WAV files. For more 
information on recording, see “Entering Information” in chapter3. 

Tips for Working in Pocket Word 
• You can change the zoom magnification by tapping View and then 

Zoom. Then select the percentage you want. Select a higher 
percentage to enter text and a lower one to see more of your 
document. 

• If you are opening a Word document created on a desktop PC, select 
Wrap to Window on the View menu so that you can see the entire 
document. 

Microsoft Pocket Excel 
Microsoft Pocket Excel works with Microsoft Excel on your desktop PC to 
give you easy access to copies of your workbooks. You can create new 
workbooks on your hp Jornada, or you can copy workbooks from your 
desktop PC to your hp Jornada. Synchronize workbooks between your 
desktop PC and your hp Jornada so that you have the most up-to-date 
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content in both locations. Pocket Excel provides fundamental spreadsheet 
tools, such as formulas, functions, sorting, and filtering, which enable you 
to create simple workbooks, such as expense reports and mileage logs.  

To use Pocket Excel 

1. On the Start menu, tap Programs, and then tap the Pocket 
Excel icon. 

2. Tap the name of a workbook in the file list. 
–or– 
Tap New to open a blank workbook.  

 

 

To open a template rather than a blank workbook, select a template for new 
workbooks. On the Tools menu, tap Options, and then browse to select the 
default template. When you tap New, the template appears with appropriate 
text and formatting already provided. 

 

 
You can open only one workbook at a time; when you open a second 
workbook, you will be asked to save the first. You can save a workbook 
you create or edit in a variety of formats, including Pocket Excel (.pxl) and 
Excel (.xls). 

Tips for Working in Pocket Excel 
• View in full-screen mode to see as much of your worksheet as possible. 

Tap View and then tap Full Screen. To exit full-screen mode, tap 
Restore. 

• If your workbook contains sensitive information, you can protect it with 
a password. To do so, open the workbook, tap Edit, and then tap 
Password. 

• Show and hide window elements. Tap View and then tap the 
elements you want to show or hide. 

• Freeze panes on a worksheet. First, select the cell where you want to 
freeze panes. Tap View and then tap Freeze Panes. You might 
want to freeze the top and leftmost panes in a worksheet to keep row 
and column labels visible as you scroll through a sheet. 
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• Split panes to view different areas of a large worksheet. Tap View 
and then tap Split. Then drag the split bar to where you want it. To 
remove the split, tap View and then tap Remove Split. 

• Show and hide rows and columns. To hide a row or column, select a 
cell in the row or column you want to hide. Tap Format, then tap 
Row or Column, and then tap Hide. To show a hidden row or 
column, tap Tools, then tap Go To, and then type a reference that is 
in the hidden row or column. Tap Format, then tap Row or 
Column, and then tap Unhide. 
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Microsoft Windows Media Player 
Use Microsoft Windows Media Player for Pocket PC to listen to digital 
audio and video files, such as songs or movie clips. Media Player supports 
sound files recorded in Windows Media and MP3 formats. 

To start Windows Media Player 

• On the Start menu, tap Programs, and then tap the 
Windows Media Player icon. 

Indicates the progress
of the current track.

Tap to skip to
the next song.

Tap to play
a previous song.

Tap
to
stop.

Tap to play
or pause.

Tap to adjust volume.
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To save power, turn off the display while listening to music on your hp Jornada. 
To turn off the display, press and hold the notification button/LED. (Press the 
notification button/LED again to turn on the display.)  

 

 

You can copy music files to enjoy on your hp Jornada by converting or 
“ripping” files from your favorite audio CDs or by downloading songs from a 
Web site such as EMusic.com. The CD included with your hp Jornada has 
sample songs from Emusic.com and the MusicMatch JukeBox application, which 
can be used to record songs from your favorite audio CDs in a format that can 
be played on your hp Jornada. 

 

 

 

Your hp Jornada is uniquely identified by a UUID (Universally Unique ID). Many 
publishers of digitally secured content, such as MP3 music files and electronic 
books (eBooks) use digital rights management that relies on the device’s UUID to
prevent unauthorized usage. After your hp Jornada has been serviced or 
repaired, you may be unable to access digitally secured content that you had 
downloaded prior to the service. In such cases, contact the content publisher for 
assistance. 

 

 

Working with Audio Files on a CompactFlash Card 
Because songs and audio files can use a lot of storage memory, you might 
want to store them on a CompactFlash memory card. For more information 
on installing a CompactFlash card and working with files on the card, see 
“CompactFlash Cards” under “Accessories” in chapter 6. 
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Microsoft Reader 
Use Microsoft Reader to read eBooks on your hp Jornada. Download 
books to your desktop PC from eBook Web sites. Then, use ActiveSync to 
copy the book files to your hp Jornada. The books appear in the Reader 
Library.  

Each book consists of a cover page, an optional table of contents, and the 
pages of the book. You can 

• Page through the book by using the up/down control on your hp 
Jornada or by tapping the page number on each page. 

• Annotate the book with highlighting, bookmarks, notes, and drawings. 
• Search for text and look up definitions for words. 
The Reader Guidebook is preinstalled on your hp Jornada, and contains 
all the information you will need to use Microsoft Reader. To open the 
Guidebook, tap Help on the Reader command bar. Or, on a book page, 
tap and hold on the book title, and then tap Help on the pop-up menu. 

To start Microsoft Reader 

• On the Start menu, tap Programs, and then tap Microsoft 
Reader.  

 

Getting eBooks for Your hp Jornada 
You can download book files from the Web. Just visit your favorite eBook 
retailer and follow the instructions to download the book files. Sample 
books and a dictionary are also included in the MSReader folder in the 
Extras folder on the Pocket PC Companion CD.  
 

 

Your hp Jornada is uniquely identified by a UUID (Universally Unique ID). Many 
publishers of digitally secured content, such as MP3 music files and eBooks, use 
digital rights management that relies on the device's UUID to prevent 
unauthorized usage. After your hp Jornada has been serviced or repaired, you 
may be unable to access digitally secured content that you had downloaded 
prior to the service. In such cases, contact the content publisher for assistance. 
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Using the Library 
The Library is your Reader home page; it displays a list of all books stored 
on your hp Jornada or storage card. 

To open the Library 

• On the Reader command bar, tap Library.  
–or– 
On a book page, tap the book title and then tap Library on the 
pop-up menu. 

 

To open a book 

• Tap a title in the Library list. 
 

Tap to open a book.

Tap to scroll through
the Library list.

Tap to specify
the books you

want to display
in the list.

Tap to select
a sort order.

Tap here to
navigate to

other parts of
the Reader.

Reading a Book 
Each book consists of a cover page, an optional table of contents, and the 
pages of the book. Navigation options are listed in the bottom portion of 
the cover page.  
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The first time you open a book, you will probably want to go to the first 
page or to the table of contents, if there is one. Subsequently, whenever 
you open the book, you will be automatically taken to the last page you 
read. 

In addition to the text, each book page includes a page number and book 
title. 

Drag to select text and
then tap an option.

Tap arrows to turn
the page, or tap and
hold page # to bring
up page riffle.

Tap to select
a navigation

option.

You can also page through a book by using the up/down control on your 
hp Jornada. 

Using Reader Features 
Reading a book electronically gives you several options not available with 
paper books. These options are available from any book page. 

Select text by dragging across the text on the page. Then, tap an option 
on the pop-up menu, as described here: 
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• Search for text.   Find text in a book by tapping Find on the pop-
up menu. Enter the word you want to search for, and tap the desired 
Find option. Reader highlights the found text on the page. To close 
Find, tap outside the box. To return to your original page, tap the title 
and then tap Return on the pop-up menu. 

• Copy text.   You can copy text from books that support this feature 
into any program that accepts text. On a book page, select the text 
you want to copy, and then tap Copy Text on the pop-up menu. The 
text can be pasted into the program of your choice. 

• Bookmarks.   When you add a bookmark to a book, a color-coded 
bookmark icon appears in the right margin. You can add multiple 
bookmarks to a book. Then, from anywhere in the book, tap the 
bookmark icon to go to the bookmarked page. 

• Highlights.   When you highlight text, it appears with a colored 
background.  

• Notes.   When you attach a note to text, you enter the text in a 
notepad that appears on top of the book page. A Note icon will be 
displayed in the left margin. To show or hide the note, tap the icon. 

• Drawings.   When you add a drawing, a Drawing icon appears in 
the lower-left corner of the page, and drawing tools appear across the 
bottom of the page. Draw by dragging your stylus. 

• Annotations.   To see a list of a book’s annotations, including 
bookmarks, highlights, text notes, and drawings, tap Annotations 
Index on the book’s cover page. You can tap an entry in the list to 
go to the annotated page. 

Removing a Book 
When you finish reading a book, you can delete it to conserve space on 
your hp Jornada. If a copy of the book is stored on your desktop PC, you 
can download it again at any time.  

To remove a book from your hp Jornada, tap and hold the title in the 
Library list, and then tap Delete on the pop-up menu. 
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MSN MessengerMSN MessengerMSN MessengerMSN Messenger    
MSN Messenger is an instant messaging program that lets you 

• See who is online. 
• Send and receive instant messages. 
• Have instant message conversations with groups of contacts. 
 
To use MSN Messenger, you must purchase and install an optional modem 
and have an account with an ISP. For more information, see “Connecting 
to the Internet or to a Network” in chapter 5. 

In addition, you must have a Microsoft Passport account or a Microsoft 
Exchange e-mail account. You must have a Passport to use MSN 
Messenger Service. If you have a Hotmail® or MSN account, you already 
have a Passport. Once you have obtained either a Microsoft Passport or a 
Microsoft Exchange account, you are ready to set up your account. 
 

 
Sign up for a Microsoft Passport account at http://www.passport.com. Get a 
free Microsoft Hotmail e-mail address at http://www.hotmail.com.  

 

To switch to MSN Messenger  

• On the Start menu, tap Programs, and then tap the MSN 
Messenger icon.  

Setting Up  
Before you can connect, you must enter Passport or Exchange account 
information. 

To set up an account and sign in 

1. On the Tools menu, tap Options. 
2. On the Accounts tab, enter your Passport or Exchange account 

information. 
3. To sign in, tap the sign-in screen and enter your e-mail address 

and password. 
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 If you already use MSN Messenger on your desktop PC, your contacts will 
show up on your device without being added again.   
 

Working with Contacts 
The MSN Messenger window shows all of your messenger contacts at a 
glance, divided into Online and Not Online categories. From this view, 
while connected, you can chat, send e-mail messages, block the contact 
from chatting with you, or delete contacts from your list using the pop-up 
menu. 

Tap and hold to display
a pop-up menu of actions.

Tap a contact to start a chat.
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To see others online without being seen, on the Tools menu, tap My Status, 
and then tap Appear Offline.  

 

  

 

If you block a contact, you will appear offline but will remain on the blocked 
contact’s list. To unblock a contact, tap and hold the contact, then tap 
Unblock on the pop-up menu.  

 

 

Chatting with Contacts 
Tap a contact name to open a chat window. Enter your message in the text 
entry area at the bottom of the screen (or tap My Text to enter a preset 
message), and then tap Send. To invite another contact to a multi-user 
chat, on the Tools menu, tap Invite, and then tap the contact you want to 
invite. 
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To switch back to the main window without closing a chat, tap the Contacts 
button. To revert to your chat window, tap Chats, and then select the person 
with whom you were chatting.   

 

hp image viewer 
The hp image viewer application enables you to view and edit image files 
stored on your hp Jornada. You can view images in the JPG, BMP, 2BP, 
GIF, and PNG formats. 
 

 

The hp image viewer application works great with the optional hp Pocket 
Camera and pocket camera software, enabling you to take pictures and view 
them immediately on your hp Jornada. The pocket camera software is 
preinstalled on your hp Jornada. The hp Pocket Camera is available as an 
optional accessory. For more information, see the Accessories Guide, or visit 
the hp Jornada Web site at www.hp.com/jornada. 

 

 
You can view pictures on your hp Jornada in three ways: 

• Browse mode shows small "thumbnails" of all the images on your hp 
Jornada, with a preview of the current image.  

• View mode displays a single image at full size.  
• Slideshow displays images sequentially, resized to fit your screen.  

To start hp image viewer 

1. On the Start menu, tap Programs, and then tap the hp 
applications folder.  

2. Tap the hp image viewer icon. 
 
By default, hp image viewer starts in Browse mode and displays images 
that are saved in the My Documents folder on your hp Jornada.  

To view pictures in a different folder 

• On the View menu, tap Change Folder, and then select a 
folder from the drop-down list. 
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If you have an hp Jornada Pocket Camera, tap the camera icon in the 
Command bar (or tap Capture on the View menu) to switch to Capture 
mode. If the camera is not installed, switching to Capture mode will display the 
“no camera” icon, . For more information on the hp Jornada Pocket 
Camera, see the Accessories Guide, or visit the hp Jornada Web site at 
www.hp.com/jornada. 

 

 

Browse Mode 
Browse mode displays thumbnail views of the pictures in the current folder 
and information about the selected picture. 
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Tap the picture in the Preview window to switch to View mode and view the 
picture at actual size. 
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From Browse mode, you can perform file actions (rename, copy, or delete) 
on selected images. You can also record sounds files to go with a specific 
images. 

Renaming, Copying, Deleting, and Rotating Images 
Use the Edit menu to rename, delete, move, copy, and rotate images. 
When renaming an image, do not enter the file name extension (for 
example, .jpg) 
 

 
You can delete, move, and copy several images at once. Select multiple images 
by tapping the triangle in the upper left corner of the thumbnail images, or tap 
Mark on the Edit menu.  

 

Recording Sound Files  
You can record sound files to go with your images. When you display an 
image with an associated sound file, the sound file is played (unless the 
Play review-related sounds option has been disabled). An image 
that has an associated sound file has a musical note icon on its thumbnail.  

To record a sound file to go with an image  

1. In Browse mode, select the image.  
2. Tap the Sound button on the menu bar to display the Recording 

toolbar.  
3. On the Recording toolbar, tap the Record button.  
4. Speak into the microphone or record the sound.  
5. When you have finished, tap the Stop button on the Recording 

toolbar. 
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View Mode 
Use View mode to view a picture on your hp Jornada screen at actual 
size. 

To switch to View mode  

• Tap the picture in the Preview window. 
–or– 
On the View menu, tap Actual Size.  

 

To close hp image viewer  

• Tap OK. 
 
If the image is too large to fit on the screen, the Overview window in the 
lower-right corner of the image displays a thumbnail of the entire image. A 
black rectangle in the Overview window marks the area of the image that 
is displayed in the main window. Display other parts of the image by 
tapping an area in the thumbnail, by scrolling with the navigation pad, or 
by dragging the stylus on the screen. 

Slideshow Mode 
In Slideshow mode, pictures are resized (and/or rotated) to fit the screen 
of your hp Jornada. You can choose whether the slideshow automatically 
displays the next picture in sequence after a short delay, or whether you 
change the picture by pressing the navigation pad or the up/down control.  

To start the slideshow  

• On the View menu, tap Slideshow.  
 

To stop the slideshow  

• Press the action button.  
 

To set slideshow options 

1. On the View menu, tap Options, and then tap the Slideshow 
tab.  

2. Select from the following slideshow options:  
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• Sequence. To automatically play the slideshow, select the order 
in which you want pictures displayed: Forward, Reverse, or 
Random. To control the slideshow manually (by rocking the 
action button to display the next picture), select Off.  

• Delay. Set the delay time (in seconds) you want the slideshow 
to wait before it automatically displays the next picture.  

• Wrap around. To repeat the slideshow after the final picture 
has been displayed, select the Wrap around check box. 
Clear the check box if you want the slideshow to stop after the 
last picture.  

• Auto-rotate. Select the Auto-rotate check box to rotate 
pictures if necessary to better fit the screen. Select either 
Clockwise or Anti-clockwise to determine the direction of 
rotation. 

• Show filename and Show date. Select Show filename 
and/or Show date to display information about the picture on 
the screen during the slideshow.  

• Play audio. Select Play audio to play any associated sound 
files when the picture is displayed.  

 

Sending Images  
You can also use hp image viewer to send images by e-mail, send images 
by infrared, or copy and paste images into Word documents and notes. 

To send an image as an attachment to an e-mail 
message  

1. In Browse mode, select the image that you want to send.  
2. On the Send menu, tap E-Mail.  

This will launch Pocket Inbox and open a new e-mail with the 
image as an attachment.  

 

To send an image to another PDA by infrared  

1. In Browse mode, select the image that you want to send.  
2. On the Send menu, tap Infrared.  
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3. Align the infrared ports on your hp Jornada with the infrared ports 
on the receiving device, and set the receiving device to receive 
the file.  

  

To send an image to an infrared-equipped printer or 
desktop PC  

1. In Browse mode, select the image that you want to send.  
2. On the Edit menu, tap Send IrOBEX.  
3. Align the infrared ports on your hp Jornada with the infrared ports 

on the receiving device.  
  

To copy an image to a document  

1. In Browse mode, select the image that you want to copy.  
2. On the Edit menu, tap Copy to Clipboard, and then choose 

the appropriate size.  
3. Switch to the document or note into which you will paste the 

image.  
4. On the Edit menu, tap Paste.  

OmniSolve 
OmniSolve is a financial application that offers the same features as the hp 
business calculator. It is designed specifically for real estate, retail, and 
business professionals who use personal digital assistants to make financial 
decisions quickly and accurately. OmniSolve employs a form-filling 
metaphor to provide a rich problem-solving environment that is 
unparalleled in ease of use, power, and flexibility. 

To start OmniSolve 

• On the Start menu, tap Programs, and then tap the OmniSolve 
icon. 

 
For detailed help and procedures about using OmniSolve, refer to online 
Help. 
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CodeWallet Pro 
CodeWallet Pro allows you to easily store, organize, and retrieve personal 
information, such as credit card numbers, favorite URLs, and emergency 
phone numbers. CodeWallet includes information forms for your 
convenience, and stores your data in encrypted, password-protected files.  
 

 CodeWallet Pro may not be included on some models of the hp Jornada. 
 

 

To start CodeWallet Pro 

• On the Start menu, tap Programs, and then tap the 
CodeWallet Pro icon. 

 
For detailed help and procedures about using CodeWallet Pro, refer to 
online Help or the CodeWallet Pro User’s Guide on the Pocket PC 
Companion CD. 
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9 | Troubleshooting 

If you encounter difficulty while using your hp Jornada, this chapter will 
help you find answers. If you need information about troubleshooting 
ActiveSync or connecting to your desktop PC, click Microsoft 
ActiveSync Help on the Help menu in ActiveSync. 

The information in this chapter will help you 

• Reset your hp Jornada. 
• Restore your hp Jornada to the factory default settings. 
• Troubleshoot basic problems. 
• Troubleshoot problems with remote connections. 
• Troubleshoot problems with the display and touch screen. 
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Resetting Your hp Jornada 
Occasionally, you may need to reset your hp Jornada; for example, you 
should reset after you restore data from your desktop PC or when the 
operating system stops responding. Resetting your hp Jornada is similar to 
restarting your desktop PC. It restarts the operating system and preserves 
any saved data, but you will lose any unsaved data. 

Reset after restoring data from a backup file or when your hp Jornada 
appears to be “frozen” or “locked up.” 

 
When you reset, you lose unsaved data in all open documents or programs. Use 
hp task switcher to close all open documents and programs before you reset.   

 

To reset 

1. Remove your hp Jornada from the cradle. 
2. Remove the CompactFlash card (if installed).  
3. Use the stylus to press the red reset button on the back of the hp 

Jornada, as shown in the following illustration. 

 

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 9 | Troubleshooting | 133 

Restoring Factory Defaults 
In some cases, such as when your hp Jornada does not respond after 
being reset or when you forget your password, you may need to restore 
your hp Jornada to the factory default settings. This erases all data not 
stored in the hp safe store folder or on a CompactFlash memory card. All 
information you have entered in RAM, including all files, system settings, 
and programs you have installed, may be erased.  

To ensure the safety of your information should it be necessary to restore 
the factory defaults, you should regularly back up your data to your 
desktop PC (using ActiveSync), to a CompactFlash card (using the hp 
backup application), or to the hp safe store folder (using the hp emergency 
backup application). For more information on backing up data, see 
“Backing Up and Restoring Data” in chapter 6. 
 

 

Restoring the factory default settings erases all files, programs, and data stored 
in RAM. You can restore data from a backup file saved on your desktop 
computer, on a CompactFlash card, or in the hp safe store folder. (For more 
information, see “Backing Up and Restoring Data” in chapter 6, or ActiveSync 
Help on your desktop computer.) 

 

 

To restore the factory defaults  

1. Disconnect all cables, including the ac adapter, from your hp 
Jornada. 

2. Remove the backup battery. Use the stylus to hold the backup 
battery lock in the OPEN position, and then slide out the backup 
battery tray.  

3. Remove the main battery. 
4. Wait at least 5 minutes, and then reinstall the main battery, 

reinstall the backup battery, and reconnect the ac adapter. (For 
more information, see “Using Your hp Jornada for the First Time” 
in chapter 2.)  

5. Your hp Jornada should turn on automatically and display the 
Welcome Wizard. 

6. If you have enabled hp emergency backup, you will be prompted 
to restore your PIM databases from the hp safe store folder.   
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After you restore the factory defaults, you will need to complete the 
Welcome Wizard and reestablish a partnership with your desktop PC. You 
may also want to restore data to your hp Jornada from your most recent 
backup file. For more information, see “Using Your hp Jornada for the First 
Time” in chapter 2, and “Backing Up and Restoring Data” in chapter 6. 

Basic Problems 
If you have a specific problem, review the information below to see if you 
can quickly find the answer. Or, visit the hp Web site at 
www.hp.com/jornada for more information about common difficulties. 
 
Problem Diagnosis/Remedy 

hp Jornada does not turn 
on when not connected to 
ac power. 

Power is too low to run your hp Jornada. 
Connect to ac power, and then turn on 
your hp Jornada. (Charge the battery 
regularly to avoid running out of battery 
power.)  

Battery runs out of power 
quickly. 

You are using your hp Jornada in ways 
that drain power quickly. Use external 
power to charge and power your device 
whenever possible, especially when 
listening to music or using CompactFlash 
cards.  

–or– 

Alerts and notifications are causing your 
hp Jornada to turn on, even when you are 
not using it. Check the “wake up sources” 
in the Power Preferences page in hp 
settings.  

For more information, see “Managing 
Power” in chapter 6. 
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Problem Diagnosis/Remedy 

hp Jornada automatically 
shuts down/suspends. 

Power is too low. When a critically low 
power condition is encountered, the hp 
Jornada initiates a safety shutdown. 
Connect to ac power and charge the 
battery.  

–or– 

Auto-suspend activated. To conserve 
power, the hp Jornada auto-suspends if it 
is idle for 1 minute immediately after 
power is turned on. It also auto-suspends if 
it is continuously idle for 5 minutes. 

–or– 

hp Jornada is locked up. Connect to 
external power, and reset your hp 
Jornada. (See “Resetting your hp Jornada” 
in this chapter.) (Caution: You may lose 
any unsaved data when you reset.) 

hp Jornada locks up when 
running applications, or it 
runs slowly. 

hp Jornada is locked up. Connect to ac 
power, and reset. (See “Resetting your hp 
Jornada” in this chapter.) Note: Check to 
ensure that the device is not running low 
on power, and avoid running several 
applications at the same time. Use hp task 
switcher to close applications that are not 
in use. 
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Problem Diagnosis/Remedy 

hp Jornada does not turn 
on or display appears to 
be off, even though power 
is on.  

The display is off. Press and hold the 
notification button/LED to turn on the 
display. 

–or– 

There is not enough light to see the 
display. Turn on lights or move to a room 
with more light. Use hp settings to increase 
the brightness of the display. Press and 
hold the power button to turn on the 
backlight. Change hp settings to use the 
light sensor to automatically turn on the 
backlight in dark conditions.  

–or– 

The device has been reset. After a reset, 
the screen remains blank for 
approximately 3 seconds after pressing the 
power button. 

–or– 

hp Jornada has run out of power. Charge 
the device by connecting to ac power 

Backup file created with 
the hp backup application 
on another hp handheld 
device cannot be restored 
to the hp Jornada.  

Only PIM data can be migrated to hp 
Jornada 560 series personal digital 
assistants. Because the hp Jornada 560 
series personal digital assistant uses a new 
version of the Pocket PC operating system, 
it is recommended that you restore PIM 
data from an older device by using 
Microsoft ActiveSync or Microsoft Outlook 
rather than hp backup. Synchronize your 
older hp handheld device with Microsoft 
Outlook on your desktop PC, and then 
establish a new partnership to transfer 
data to your new hp Jornada.  
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Problem Diagnosis/Remedy 

Difficult to install or run 
software from previous hp 
handheld on hp Jornada 
560 series.  

Software that runs on previous hp 
handheld devices may not run on your hp 
Jornada 560 series personal digital 
assistant. Because the hp Jornada 560 
series personal digital assistant uses a 
different processor and a new version of 
the Pocket PC operating system, software 
built for previous-generation Pocket PCs 
(such as hp Jornada 430, 420, 520, or 
540 series) may not run on your hp 
Jornada 560 series. Check with the 
software vendor for an upgrade or newer 
version that will run on the hp Jornada 
560 series. 

Inaccurate response to 
stylus tap. 

The calibration of the touch screen may be 
off. Realign the touch screen. Press and 
hold the hp home menu hot key to open 
the Align Screen control panel. 

Unable to locate files in 
CompactFlash memory in 
applications.  

Files must be stored in the My 
Documents folder on the CompactFlash 
card. Create the My Documents folder 
using File Explorer, and move files into this 
folder. 

Data is lost. hp Jornada has run out of power. Restore 
data from a backup file on your desktop 
PC or a CompactFlash card.  

–or– 

Factory default settings have been 
restored. Restore data from a backup file 
on your desktop PC or a CompactFlash 
card.  
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Remote Connections 
This section offers troubleshooting help for connecting your hp Jornada to 
other computers. For problems communicating with your desktop PC, see 
ActiveSync Help.  

Able to dial out, but unable to make proper 
connection 
Make sure the network to which you are trying to connect supports Point-to-
Point Protocol (PPP). Your Internet service provider or network administrator 
can verify this. 

Verify that the dialing location is correct. On the Start menu, tap 
Settings, and then on the Connections tab, tap Connections. On the 
Dialing Locations tab, select the location you are dialing from and 
confirm that the settings are appropriate for that location. 

Modem connection is unreliable 
Make sure the modem is firmly seated and connected to your device and 
the telephone jack. 

Disable Call waiting. On the Start menu, tap Settings, and then on the 
Connections tab, tap Connections. On the Dialing Locations tab, 
select the Disable call waiting check box. Select the disable code 
specified by your telephone company from the drop-down list. 

Unable to use infrared transfer between Windows-
powered devices 
If you are unable to use infrared to transfer information between Windows-
powered devices, try the following: 

• Transfer only one file, or no more than 25 contact cards, at a time. 
• Position the infrared ports so that they line up and are less than 

1 meter (3 feet) but more than 5 cm (2 inches) apart. 
• Make sure nothing is between the two infrared ports.  
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• Adjust the room lighting. Some types of light interfere with infrared 
communication. Try moving to a different location or turning off some 
lights. 

Network Connection Problems 
The following solutions may help if you encounter problems when using a 
network card for network connections. Additional troubleshooting 
information is available in Connections Help on the device and ActiveSync 
Help on the desktop PC.  

• Verify that your NIC is compatible with the hp Jornada 560 series 
personal digital assistant and that you have installed the proper 
drivers for the hp Jornada. 

• In the properties for your network adapter, ensure that you have 
properly configured the IP settings, and the addresses of your DNS 
servers and/or WINS servers. Check with your network administrator 
to determine the proper settings. 

• Verify that you have added necessary server information. On the 
Start menu, tap Settings. On the Connections tab, tap Network. 
Tap your installed adapter (usually your Ethernet card's name) and 
enter any necessary information. Most networks use DHCP to assign IP 
addresses dynamically; you should not have to change or enter an IP 
address settings unless your network administrator instructs you to do 
so. 

• If Network Connection is not listed as a connection method in the 
ActiveSync dialog box when starting synchronization, wait a few 
minutes and try again. Also, if synchronization does not start right 
away, the network is probably busy, and it may take a minute for your 
device to connect to the network.  

• Verify with your network administrator that your user name and 
password are correct. 

• Verify with your network administrator that the network you are trying 
to connect to is available, or try to connect to it from another 
computer.  
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• You may need to change the device name if you are trying to connect 
to a network and cannot because another device with the same name 
is already connected. To change the device name, on the Start menu, 
tap Settings. On the System tab, tap About, and then tap the 
Device ID tab. 

 

Cradle Connection Problems 
If you are having trouble connecting to your desktop PC using the USB 
cradle, try these possible solutions. For additional, up-to-date 
troubleshooting information, refer to ActiveSync Help on your desktop PC 
or to the Microsoft Mobile Devices Web site at 
www.microsoft.com/mobile/pocketpc.  

• Ensure you have installed the correct version of ActiveSync on your 
desktop PC. Install the version ActiveSync included with your hp 
Jornada 560 series personal digital assistant.  

• Ensure that your hp Jornada is on. 
• Ensure that you do not have any other active connections. On the 

Start menu, tap Today. Tap  or  at the bottom of the screen, 
and then tap Disconnect. 

• Ensure the cable is securely plugged into the USB port on the back of 
your desktop PC. Connect the USB cable directly to your desktop PC—
do not run the cable through a USB hub. 

• Enable the USB connection on your hp Jornada. On the Start menu, 
tap ActiveSync. On the Tools menu, Options. Under Enable 
synchronization when cradled using, select USB connection 
from the drop-down list. 

• Ensure the USB connection is enabled in ActiveSync on your desktop 
PC. Refer to ActiveSync Help on your desktop computer. If the USB 
connection is already enabled, disable the USB connection, close the 
Connection Settings window, and then reopen and re-enable the USB 
connection.  

• Reset your hp Jornada before putting it in the cradle to connect. For 
more information, see “Resetting Your hp Jornada,” earlier in this 
chapter. 
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• Always disconnect your hp Jornada before you restart your desktop 
PC.  

• Connect only one Pocket PC or personal digital assistant to your 
desktop PC at a time.  

Display Problems 
If you are having trouble viewing data on your hp Jornada screen, follow 
these suggestions. 

Screen is Blank 
Follow these steps if the screen remains dark or if the device does not 
respond when you briefly press the power button: 

• Press and hold the notification button/LED to ensure that the display is 
on. 

• Reset the device. After a reset, the screen remains blank for 
approximately 3 seconds after pressing the power button.  

• Charge the device by connecting to ac power. 

Display is Difficult to See in Dark Rooms 
Use hp settings to adjust the display brightness for optimal viewing. (Refer 
to “Adjusting Settings” in chapter 6). In very bright light, select the 
Outdoor profile in hp settings. In very dark conditions, select the Low 
Power profile. In a dark room, you may also need to turn on the backlight 
or position a lamp so that the light shines directly on the screen. Use hp 
settings to set the backlight to come on automatically in dark conditions. 

Screen is Hard to Read 
If you are having a hard time viewing a document in Notes, try changing 
the size of the view. To do this, tap a zoom percentage on the Tools 
menu. In Pocket Word and Pocket Excel, on the View menu, tap Zoom 
and then select a zoom percentage. In Pocket Internet Explorer, on the 
View menu, tap Text Size and then select a size. 
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If you are having a hard time viewing Pocket Outlook data, try enlarging 
the display font. To do this within Calendar, Tasks, or Contacts, tap Tools, 
then Options, and then select Use large font. 
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10 | Support and Service 

Web site  
You can obtain product information as well as tips and hints on how to get 
more from the hp Jornada product at our Worldwide Web site. This 
computer service is provided free of charge; you pay only for telephone 
charges and Internet service fees. To connect to this Web site from a 
computer via the Internet, go to www.hp.com/jornada.  

Customer support  
If you have questions that the User’s Guide or the Web site does not 
answer (after checking the contents and index), you can contact Hewlett-
Packard Worldwide Support and Services for Handheld Products at the 
telephone numbers listed in the following table.  

If the device requires service, contact Hewlett-Packard for service 
information, shipping instructions, and out-of-warranty service charges 
before you send your device to hp for repair.  

In countries not listed in the table, contact the Hewlett-Packard authorized 
dealer or sales office.  

Service  
For diagnostic instructions and other service information, contact one of the 
technical support numbers listed. Please do not ship your device for service 
without first contacting a Hewlett-Packard office. If your device qualifies for 
in-warranty service, be ready to supply a dated proof of purchase. In 
countries not listed in the following table, contact the Hewlett-Packard 
authorized dealer or sales office.  

Before you contact us for help, be sure to:  

1. Review the manuals whenever possible.  
2. Have the following information about the product:  
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• model number  
• serial number  
• purchase date  

3. Have your product ready to use. The support personnel may ask 
you to run tests and other operations.  

4. Organize your question or problem. The more detailed 
information you can provide, the quicker the support personnel 
can help you.  

 

Contacting Hewlett-Packard Worldwide  
You will be pleased to know that our commitment to quality does not stop 
at the sale. Our worldwide customer support network is available to give 
you personal telephone service should you need it.  

Telephone  

Argentina 

All other cities 

   
54-11-4778-8380 
54-0810-555-5520  

Australia  61-3-88778000  

Austria  43-0660-6386  

Belgium (Dutch) 32-(0)2-6268806  

Belgium (French) 32-(0)2-6268807  

Brazil  
Sao Paulo 
All other cities 

 
55-11-3747-7799 
55-0800-157751 

Canada  1-905-2064663 

Chile  56-800-360999  

China  86-(0)10-65645959  

Czech Republic 42-(0)2-4717327  

Buenos Aires  

Country/Region  
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Telephone  

Denmark  45-(0)39-294099  

Finland  358-(0)20347288  

France  33-(0)1-43623434  

Germany  49-(0)1-805258143  

Greece  30-(0)1-6896411  

Hong Kong  852-300-28555  

Hungary  36-(0)1-12524505  

India  91-11-6826035  

Indonesia  62-21-3503408  

Ireland  353-(0)1-6625525  

Israel  972-9-9524848  

Italy  39-(0)2-26410350  

Japan  81-0570-000511  

Korea  
Seoul 
All other cities 

 
82-(0)2-32700700  
82-080-9990700 

Malaysia  60-(0)3-2952566  

Mexico  
Mexico City 
All other cities 

 
52-58-9922 
01-800-4726684 

Netherlands  31-(0)20-6068751  

New Zealand  64-(0)9-3566640 

Norway  47-22-116299  

Philippines  66-2-8673551  

Poland  48-22-375065  

Country/Region  
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Telephone  

Portugal  351-4417199 

Russia  7-095-9235001  

Singapore  65-2725300  

South Africa / Middle East 41-22-7807111  

Spain  34-91-782-0109  

Sweden  46-(0)8-6192170  

Switzerland  41-(0)-848-801111 

Taiwan  886-2-27170055  

Thailand  66-2-6614000  

Turkey  90-1-2245925  

UK  44-870-608-3003  

USA 208-323-2551 

Venezuela  

Caracas 

All other cities 

 

2-207-8488 

58-800-10111 

Vietnam 84-88234530 

All Customer Care Centers are available during office hours. Pre-sales 
Information in the USA is available 24 hours per day, 7 days per week. 
Support & Service in the USA can be contacted from 5 am to 5 pm Pacific 
Time, Monday through Friday. 

  

Country/Region  
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Warranty 

Important: This is your hardware product warranty statement. Read it 
carefully.  

Warranty terms may be different in your country. If so, your authorized hp 
dealer or Hewlett-Packard sales and service office can give you details. 

One year limited hardware warranty 
Hewlett-Packard (hp) warrants this hardware product against defects in 
material and workmanship for a period of one year from receipt by the 
original end-user purchaser. 

If hp receives notice of the above-defined defects during the warranty 
period, hp will either, at its option, repair or replace products that prove to 
be defective. 

Should hp be unable to repair or replace the product within a reasonable 
amount of time, the customer's alternate exclusive remedy shall be a refund 
of the purchase price upon return of the product. 

Limitation of warranty 
The above warranty shall not apply to defects resulting from: misuse; 
unauthorized modification; opening for any reason; operation or storage 
outside the environmental specifications for the product; in-transit damage; 
improper maintenance; or defect resulting from use of non-hp software, 
accessories, media, supplies, consumables, or such items not designed for 
use with the product. 

hp makes no other express warranty, whether written or oral, with respect 
to this product. 

Any implied warranty of merchantability or fitness for a particular purpose 
is limited to the one-year duration of this written warranty.  
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Some states, provinces, or countries do not allow limitations on how long 
an implied warranty lasts, so the above limitation or exclusion may not 
apply to you. 

This warranty gives you specific legal rights, and you may also have other 
rights that vary from state to state, province to province, or country to 
country. 

Limitation of liability and remedies 
The remedies provided above are the customer's sole and exclusive 
remedies. 

In no event shall hp be liable for any direct, indirect, special, incidental, or 
consequential damages (including lost profit), whether based on warranty, 
contract, tort, or any other legal theory.  

Some states, provinces, or countries do not allow the exclusion or limitation 
of incidental or consequential damages—including lost profit—so the 
above limitation or exclusion may not apply to you. 

Consumer transactions in Australia, New Zealand 
and the United Kingdom  
The preceding disclaimers and limitations shall not apply to consumer 
transactions in Australia, New Zealand and the United Kingdom, and shall 
not affect the statutory rights of consumers.  

For consumers in Australia  
The above warranty terms and any other warranty statement enclosed with 
this product, except to the extent lawfully permitted, do not exclude, 
restrict, or modify and are in addition to the statutory rights implied by the 
Trade Practices Act 1974 or any corresponding State or territory 
legislation applicable to the sale of this product to you. If you have any 
queries about your rights, contact the Hewlett-Packard Customer Care 
Center at 61-3-88778000.  
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For consumers in New Zealand  
The above warranty terms or any other warranty statement enclosed with 
this product, except to the extent lawfully permitted, do not exclude, restrict 
or modify and are in addition to the statutory rights implied by the 
Consumer Guarantees Act 1993 applicable to the sale of this product to 
you. If you have any queries about your rights contact the Hewlett-Packard 
End User Support line at 0800-733547. 

hp Software Product License Agreement and 
hp Software Product Limited Warranty 
This hp product contains preinstalled software programs. Please read the 
hp Software Product License Agreement before proceeding.  

Important: Carefully read this License Agreement and the Limited 
Warranty statement before operating the equipment. The rights to the 
software are licensed, not sold. hp or its licensors continue to own all 
intellectual property rights to the software, and you will be granted certain 
rights to use the software upon your acceptance of this license. Rights in 
the software are offered only on the condition that you agree to all terms 
and conditions of the License Agreement. Operating the equipment 
indicates your acceptance of these terms and conditions. If you do not 
agree to the terms and conditions of the License Agreement, return the 
complete package for a full refund now. 

hp Software Product License Agreement 
The hp Software Product License Agreement shall govern the use of all 
software that is provided to you, the customer, as part of this hp product 
with the exception of Microsoft Software. Microsoft Products are licensed 
to you under the Microsoft End User License Agreement (EULA) contained 
in the Microsoft documentation. Any third-party software supplier's 
warranty terms that may be found online, or in any documentation or other 
materials contained in the product packaging, shall govern the use of that 
third-party software. 

The following License Terms govern the use of the software: 
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Use 
You may only use the software on a single computer. You may not reverse, 
assemble, or decompile the software.  

Transaction in European Union member states: The prohibition against 
decompilation shall be subject to Directive 91/250/EEC. 

Copies and adaptations 
You may make copies or adaptations of the software (a) for archival 
purposes, or (b) when copying or adaptation is an essential step in the use 
of the software with a computer so long as the copies and adaptations are 
used in no other manner.  

You have no other rights to copy unless you acquire an appropriate license 
to reproduce which is available from hp for some software.  

You agree that no warranty, free installation, or free training is provided 
by hp for any copies or adaptations made by you.  

All copies and adaptations of the software must bear the copyright 
notice(s) contained in or on the original.  

Ownership 
You agree that you do not have any title to or ownership of the software, 
other than ownership of the physical media. You acknowledge and agree 
that the software is copyrighted and protected under the copyright laws. 
You acknowledge and agree that the software or part thereof may have 
been developed by a third-party software supplier named in the copyright 
notice(s) included with the software, who shall be authorized to hold you 
responsible for any copyright infringement or violation of this or their own 
License Agreement.  

Transfer of rights in software 
You may transfer rights to the software to a third party only as part of the 
transfer of all your rights and only if you obtain the prior agreement of the 
third party to be bound by the terms of this License Agreement. Upon such 
a transfer, you agree that your rights to the software are terminated and 
that you will either destroy all your copies and adaptations or deliver them 
to the third party. Transfer to a U.S. government department or agency or 
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to a prime or lower tier contractor in connection with a U.S. government 
contract shall be made only upon prior written agreement to terms required 
by hp.  

Sublicensing and distribution 
You may not lease, sublicense the software, or distribute copies or 
adaptations of the software to the public in physical media, by 
telecommunication or at all without the prior written consent of hp.  

Termination 
hp may terminate this software license for failure to comply with any of 
these terms, provided hp has requested you to cure the failure and you 
have failed to do so within thirty (30) days of such notice.  

Updates and upgrades 
You agree that the software does not include updates and upgrades that 
may be available from hp under a separate support agreement. 

Export clause 
You agree not to export or re-export the software or any copy or 
adaptation in violation of the U.S. Export Administration regulations or 
other applicable regulations.  

U.S. government restricted rights  
The Software and Documentation have been developed entirely at private 
expense. They are delivered and licensed as “commercial computer 
software” as defined in DFARS 252.227-7013 (Oct 1988), DFARS 
252.211-7015 (May 1991) or DFARS 252.227- 7014 (Jun 1995), as 
“commercial item” as defined in FAR 2.101 (a), or as “Restricted computer 
software” as defined in FAR 52.227-19 (Jun 1987) (or any equivalent 
agency regulation or contract clause), whichever is applicable. You have 
only those rights provided for such Software and Documentation by the 
applicable FAR or DFARS clause or the hp standard software agreement 
for the product involved. 
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hp Software Product Limited Warranty 
Important: This hp Software Product Limited Warranty shall cover all 
software that is provided to you, the customer, as part of the hp product, 
including any operating system software. Any third-party software 
supplier's warranty terms that may be found on-line, or in any 
documentation or other materials contained in the product packaging shall 
supersede the hp Software Product Limited Warranty with regard to that 
third-party software. 

Ninety-Day Limited Software Warranty 
hp warrants for a period of NINETY (90) DAYS from the date of purchase 
that the software product will execute its programming instructions when all 
files are properly installed. hp does not warrant that the software will be 
uninterrupted or error free. In the event that this software product fails to 
execute its programming instructions during the warranty period, your 
remedy shall be replacement or refund only. Return the media to hp for 
replacement. Should hp be unable to replace the media within a 
reasonable amount of time, hp shall refund the purchase price upon return 
of the product and all copies. 

Removable media (if supplied) 
hp warrants the removable media, if supplied, upon which this product is 
recorded to be free from defects in material and workmanship under 
normal use for a period of NINETY (90) DAYS from the date of purchase. 
In the event the media proves to be defective during the warranty period, 
your remedy shall be replacement or refund only. Return the media to hp 
for replacement. Should hp be unable to replace the media within a 
reasonable amount of time, hp shall refund the purchase price upon return 
of the product and destruction of all other non-removable media copies of 
the software product. 

Notice of warranty claims 
You must notify hp in writing of any warranty claim not later than thirty 
(30) days after the expiration of the warranty period. 
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Limitation of warranty 
hp makes no other express warranty, whether written or oral, with respect 
to this product. 

Any implied warranty of merchantability or fitness for a particular purpose 
is limited to the 90-day duration of this written warranty. Some states, 
provinces, or countries do not allow limitations on how long an implied 
warranty lasts, so the above limitation or exclusion may not apply to you. 
This warranty gives specific legal rights, and you may also have other 
rights that vary from state to state, province to province, or country to 
country. 

Limitation of liability and remedies 
THE REMEDIES PROVIDED ABOVE ARE YOUR SOLE AND EXCLUSIVE 
REMEDIES. IN NO EVENT SHALL HP BE LIABLE FOR ANY DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES 
(INCLUDING LOST PROFIT), WHETHER BASED ON WARRANTY, 
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY. Some states, 
provinces, or countries do not allow the exclusion or limitation of incidental 
or consequential damages—including lost profit—so the above limitation 
or exclusion may not apply to you. 

In no case shall hp's liability exceed the purchase price for the software 
and/or product. The limitations set forth above will apply regardless of 
whether you accept the software. 

Consumer transactions in Australia and the United Kingdom: The 
disclaimers and limitations above shall not apply and shall not affect the 
statutory rights of a Consumer.
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Glossary  

ac adapter. An external power supply that converts ac power from a 
standard household electrical outlet to the low-voltage dc power required 
to operate your hp Jornada. 

Backup. A duplicate copy of your hp Jornada files and data that is stored 
on your desktop PC, on a CompactFlash card, or in the hp safe store 
folder. 

CompactFlash. A removable media for high-performance memory cards 
and other peripheral devices such as modems and NICs. 

Cradle. A desktop base for your hp Jornada that allows instant 
connectivity to a desktop PC. The cradle remains connected to your 
desktop PC, even when you remove your hp Jornada. 

DHCP (Dynamic Host Configuration Protocol). A protocol that 
assigns a dynamic IP address to your hp Jornada each time you connect to 
a network. 

Dial-up connection. A connection between your hp Jornada and 
another computer by modem. You can have a dial-up connection with an 
ISP, a network, or with a modem attached to a PC. 

Direct connection. A connection between your hp Jornada and another 
computer by means of the cradle or infrared port.  

DNS (Domain Name System). An Internet service that translates 
domain names into IP addresses. For example, the domain name 
www.jornada.com might translate as 198.125.247.4. 

Driver. A control program that enables a computer to work with a 
specific peripheral device. 

Flash ROM. See ROM. 

IMAP4 (Internet Messaging Access Protocol v4). A protocol that 
enables a computer to retrieve messages from a mail server. 

Infrared port. A communication port that uses optical (infrared) signals 
rather than wires or cables to transmit data.  

Internet. A worldwide network of computers offering services such as e-
mail, the Worldwide Web, FTP, Usenet news, and others. 
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Intranet. A network that offers services similar to the Internet, but usually 
accessible only to users within a single company or organization. 

IP (Internet Protocol). The standard by which packets of information 
are transmitted over the Internet.  

IrDA (Infrared Data Association protocol). An established standard 
for infrared communications between computers and other peripherals and 
devices. 

ISP (Internet service provider). A commercial business that provides 
Internet access to individuals or businesses, usually for a fee. 

LAN (local area network). A group of computers, usually in close 
proximity (either in the same building or in buildings in close proximity), 
that are linked together to share files and exchange data. 

Modem. A communication device that enables a computer to transmit 
data over telephone lines. 

NIC (network interface card). A card installed in a computer so that 
it can be connected to a network. NICs can provide a dedicated, full-time 
connection to a network. 

Partnership. An established relationship between your hp Jornada and 
your desktop PC for the purpose of synchronizing and transferring data.  

PIM (personal information manager). An application or set of 
applications that organizes information such as addresses, appointments, 
and notes. 

POP3 (Post Office Protocol v3). A protocol that enables a computer 
to retrieve messages from a mail server. 

PPP (Point-to-Point Protocol). The default method your hp Jornada 
uses to communicate with an ISP or network server. 

Proxy server. A server that sits between a client computer or Web 
browser and the Internet. A proxy server provides security by filtering 
requests and can improve performance by storing local copies of 
requested information. 

RAM (random access memory). Volatile memory that can be read 
and written. Data stored in RAM is retained only while power is 
maintained.  
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Remote connection. A connection between your hp Jornada and a 
remote computer or server. 

Reset. The process of restarting your hp Jornada and reinitializing the 
operating system. Performing a reset erases any unsaved data in open 
documents, but preserves data that has been saved. 

Restore. To return your device to the state it was in when data was last 
backed up. This involves copying your backup data to your hp Jornada. 

ROM (read-only memory). Nonvolatile flash memory that contains the 
Microsoft Windows for Pocket PC operating system and preinstalled 
programs. 

Serial connection. A cable connection between your hp Jornada and a 
serial (COM) port on your desktop PC. 

SLIP (Serial Line Internet Protocol). A method of connecting to the 
Internet. Similar to PPP, but older and simpler.  

SMTP (Simplified Mail Transport Protocol). A protocol for sending 
e-mail messages between computers on the Internet.  

Stylus. A pen-like utensil designed for navigating on a touch screen. 

Synchronization. The process of comparing the files or data on two 
computers to ensure that they contain exactly the same information.  

Touch screen. A touch-sensitive screen that allows you to open files, 
launch programs, and select text by touching or tapping the screen with 
the stylus. 

USB (Universal Serial Bus). A newer standard for connecting 
peripheral devices. USB supports relatively fast data transfer rates and can 
be used to connect multiple devices to a single computer. 
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Appendix  
Character Recognition 

Using Character Recognizer, you can write characters directly on your hp 
Jornada screen with your stylus, just as you would on a piece of paper. 
The characters you write are translated into typed text. Use Character 
Recognizer anywhere you want to enter text; for example, to write a note 
or to fill in fields in a dialog box.  

The default writing mode for Character Recognizer is lowercase (Jot-
compatible) mode. In this mode, you write characters in lowercase. The 
chart at the end of this appendix contains examples of how to write 
characters in lowercase mode. You can also choose to write in uppercase 
(Graffiti-compatible) mode. In this mode, you write characters in 
uppercase. If you prefer to write in uppercase mode, tap Uppercase 
Mode in Options on the input method menu. Whether a letter appears 
in uppercase or lowercase when it is converted to typed text depends on 
where in the Input panel you write it, not on the mode you have selected.  

The Character Recognizer Input panel is divided into three writing areas. 
Letters written in the left area (labeled ABC) create uppercase letters, and 
letters written in the middle area (labeled abc) create lowercase letters. 
Use the right area (labeled 123) for writing numbers, symbols, special 
characters, and punctuation.  
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The following chart is a partial display of the characters you can write 
while in lowercase mode (the dot on each character is the starting point for 
writing). Remember that even though you write a letter in its lowercase 
form, the case of the text that is displayed depends on where you write the 
letter. For example, if you write a lowercase “a” in the ABC area, an 
uppercase “A” is displayed on the screen. 
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For more information on using Character Recognizer and for demos of all 
characters, tap  on the Character Recognizer Input panel.  
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Index 

A 
ac adapter, 2, 13, 15, 54, 80, 155
accessories, 94
AccessPanel, 6, 7, 30, 32, 33, 34
action button, 19
ActiveSync, 5, 7, 8, 47, 48, 49, 50, 51,

52, 53, 54, 55, 62, 63, 66, 67, 68,
69, 70, 73, 75, 82, 93, 97, 100, 116,
131, 138, 139, 140

adding programs. See programs
alarm, 17, 30, 87, 89
alerts, 4, 30, 86, 87
Align Screen control panel. See

display
appointments

adding notes to, 99
alarm for, 30
changing, 100
creating, 99
reminders, 99
Summary Screen, 100

AudibleManager, 6
AudiblePlayer, 6
audio files

formats, 114
playing, 7, 114, 134
ripping, 115
secured content (UUID), 115

audiobooks, 6
AvantGo, 68

B 
backing up data

about hp backup, 3
about hp emergency backup, 3
to CompactFlash card, 83
to desktop PC, 52
using ActiveSync, 52, 82, 133
using hp backup, 52, 78, 82, 83,

133
using hp emergency backup, 83,

85, 133
backlight. See display

backup file, 52, 83, 85, 136, 155
battery

about backup battery, 15
about main battery, 14
charging main battery, 14, 16, 53,

78, 134, 135
disposal, 15
extended battery pack, 14
installing backup battery, 12
installing main battery, 12
low power warning, 15, 78
replacing backup battery, 15
status indicator, 13, 16, 17, 28, 78
typical power usage, 78

Block Recognizer, 30, 34
books online. See Reader
browsing

an intranet, 63
the Web, 63, 65

buttons. See hardware buttons

C 
calculator. See OmniSolve
Calendar

about, 5, 97, 98
adding notes to, 99
alarm for, 30
backing up, 3, 82, 83
creating an appointment, 99
customizing display of, 98
hot key, 18, 86
meeting requests, 100, 101
Summary Screen, 100
synchronizing, 48
zooming, 142

cellular phone. See mobile phone
Character Recognizer, 110, 159, 161
chat. See MSN Messenger
closing programs. See programs
CodeWallet Pro, 6, 7, 109, 129
Command bar, 26
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CompactFlash card
about, 82, 95, 155
connecting to mobile phone, 59
connectivity kit, 59
installing, 95
memory, 52, 78, 81, 82, 83, 84,

133, 137
modem, 58
NIC, 58
power usage, 14, 78, 80, 134
slot, 96
storing audio files on, 115

connecting
by infrared, 55, 59
by LAN, 50
by mobile phone, 59
by modem, 58
by USB cradle, 53
closing a connection, 62
to a network, 139
to desktop PC, 53, 55
to Internet, 57, 60
to ISP, 60
to mail server, 69
to remote computer, 57

contacting HP, 144
Contacts

about, 5, 97, 101
adding notes to, 103
backing up, 3, 82, 83
categorizing, 103
creating, 102
customizing display of, 102
finding, 103
hot key, 18, 86, 88
sorting, 18
Summary Screen, 104
synchronizing, 48
viewing, 103
zooming, 142

converting files, 51
cover, 152
cradle. See USB cradle
customer service. See technical

support

D 
dc jack, 13, 54
DHCP protocol, 155
dial-up connection, 155
direct connection, 155
display

Align Screen control panel, 4, 18,
22, 137

backlight, 4, 14, 19, 78, 79, 86,
136, 141

brightness, 4, 141
cleaning, 19
radiated interference, 20
troubleshooting, 136, 141
turning off, 17, 79, 115
turning on, 17, 19, 79

DNS, 155
drawings

adding to book text, 119
creating, 39
resizing, 40
selecting, 40
zooming, 40

drivers. See software drivers

E 
eBooks. See Reader
e-mail

adding recordings to, 41
composing messages, 73
connecting to mail server, 69, 70
deleting messages, 70
folder behavior, 75, 76
moving messages, 75
organizing messages, 75
reading messages, 71, 72, 73
receiving attachments, 72
sending messages, 68, 74
signatures, 32
synchronizing, 48, 69
working offline, 70

EMusic.com, 115
Exchange, 51, 68, 69, 74, 97, 120
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F,G 
factory default settings, 133. See

restoring factory defaults
File Explorer, 45, 92, 94, 137
files

converting, 51
transferring, 51

Find feature, 45
Flash ROM, 3, 157
GSM file format, 43

H 
hardware buttons

about, 16
configuring, 90

hp backup. See backing up data
hp emergency backup. See backing

up data
hp home menu, 4, 24, 90, 91, 92
hp home menu hot key, 18, 24
hp hot keys, 16, 18, 19, 88, 90
hp image viewer

about, 4, 109
adding images to a document, 128
adding recordings to an image, 125
Browse mode, 124, 125
changing folders, 123
file formats, 123
sending images, 127, 128
Slideshow mode, 126
starting, 123
View mode, 126

hp Jornada
caring for, 19
hardware features, 10
package contents, 2
registering, 20
turning off, 16
turning on, 16
warranty, 147

hp Jornada User’s Guide online
version, 8

hp Microchai, 4
hp Pocket Camera, 4, 123, 124
hp quick menu, 4, 18
hp safe store folder, 3, 80, 81, 82, 83,

85, 94, 133

hp settings, 4, 79, 86, 87, 88, 136, 141
hp task switcher, 4, 19, 24, 25, 28, 81,

82, 83, 84, 132, 135
HPC Notes, 6

I 
images. See hp image viewer
IMAP4 protocol, 60, 69, 76, 155
Inbox, 83

about, 5
connecting to mail server, 69
My Text, 44
setting up email service, 69
synchronizing, 48, 69

infrared modem, 59
infrared port, 47, 51, 53, 55, 59, 80,

101, 127, 128, 138, 155
Input panel, 30, 31, 110, 159
installing programs. See programs
instant messages. See MSN

Messenger
interference, radiated, 20
Internet, 155
Internet service provider. See ISP
intranet, 57, 63, 156
IP protocol, 156
IrDA protocol, 55, 59, 156
ISP, 156

connecting to, 60

L 
LAN, 53, 156
LED status indicator

blinking amber, 17
blinking green, 17
solid amber, 16, 17, 41, 78
solid green, 13, 16, 17, 78

Letter Recognizer, 30, 35

M 
mail. See e-mail
Media Player. See Windows Media

Player
meeting requests, 100, 101
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memory
hp safe store folder, 80
managing, 80, 81
program, 80, 81
storage, 42, 43, 67, 80, 81

Microsoft Exchange. See Exchange
Microsoft MSN Messenger. See MSN

Messenger
Microsoft Outlook. See Outlook
Microsoft Passport. See Passport
Microsoft Pocket Excel. See Pocket

Excel
Microsoft Pocket Internet Explorer.

See Pocket Internet Explorer
Microsoft Pocket Outlook. See Pocket

Outlook, Calendar, Contacts,
Notes, Tasks, Inbox

Microsoft Pocket Word. See Pocket
Word

Microsoft Reader. See Reader
mobile favorites

and favorite links, 66
creating, 66, 67
reducing storage memory for, 67
specifying level of links, 67, 68
synchronizing, 66
update schedule, 67
viewing, 48, 65

mobile phone, 59
modem, 156

CompactFlash card, 58
infrared, 59
installing, 58

MP3 files, 5, 7, 114, 115
MSN Messenger

about, 5, 120
blocking contacts, 122
chatting, 122
contacts, 121
instant messages, 61, 62
My Text, 44
setup, 120
starting, 120

MusicMatch JukeBox, 7, 115
My Text, 44

N 
Navigation bar, 26
navigation pad, 19

network. See LAN
network interface card, 58, 60, 139,

156
NIC. See network interface card
Notes

about, 5, 97, 108
adding to books, 119
creating, 108
drawing, 39
inputting text, 30
recording, 41
writing on-screen, 35
zooming, 141

notification button/LED, 17, 141

O 
OmniSolve, 6, 109, 128
online chat. See MSN Messenger
online Help, 2, 7, 8, 109, 128, 129
Outlook, 2, 7, 48, 51, 68, 69, 74, 75,

97, 100
owner information, 89

p 
partnership, 48, 51, 52, 134, 136, 156
Passport, 120
password, 6, 60, 89, 112, 133, 139
PCM file format, 42
pictures. See hp image viewer
PIM (personal information manager),

3, 14, 50, 51, 52, 82, 83, 84, 85,
133, 136, 156

Pocket Excel
about, 5, 109, 111
customizing display of, 112, 113
file formats, 112
opening spreadsheets, 112
passwords, 112
starting, 112
synchronizing, 111
templates, 112
zooming, 112, 141

Pocket Internet Explorer, 5, 61, 62,
63, 66, 68, 93, 141

Pocket Outlook, 1, 48, 97, 100, 142
Pocket PC Companion CD, 2, 6, 7,

34, 48, 92, 95, 116, 129

Download from Www.Somanuals.com. All Manuals Search And Download.



Index | 167 

Pocket Word
about, 5, 109, 110
drawing mode, 111
file formats, 110
opening documents, 110
recording mode, 111
starting, 110
synchronizing, 110
templates, 110
typing mode, 110
writing mode, 111
zooming, 111, 141

POP3 protocol, 60, 69, 75, 156
pop-up menus, 29
power

about, 14
ac adapter, 15, 80
checking remaining, 79
conserving, 78, 79, 88, 115
loss of, 3, 14, 78, 83, 85
low power indicator, 25
Power control panel, 16, 79

power button, 16, 19, 79, 136, 141
PPP protocol, 138, 156
profile

hp display, 4, 18, 86
hp volume, 4, 18, 86
Loud, 87
Low Power, 141
Meeting, 87
Outdoor, 141
volume, 87

program memory, 80, 81
programs

adding, 7, 92
adding to Start menu, 92
additional, 6
closing, 81, 82
for desktop PC, 7
from hp, 3, 4
from Microsoft, 5
from third parties, 6, 109
help for, 8
installing, 6, 93, 137
removing, 3, 81, 94
switching, 24, 25, 26

proxy server, 156

R 
radiated interference, 20
RAM, 156
Reader

about, 116
adding drawings to text, 119
adding notes to text, 119
annotations, 119
bookmarks, 119
copying text, 119
getting books for, 116
Guidebook, 116
highlighting text, 119
Library, 117
removing a book, 119
searching for text, 119
secured content (UUID), 116
starting, 116

record button, 17, 18, 88, 90
recording

about, 41
adding to a note, 41
adding to an e-mail message, 41
adding to images, 125
creating, 41
file formats, 42, 43
in Pocket Word, 111
playing back, 41
starting, 17
status indicator, 17, 41
stopping, 17

removing programs. See programs
reset button, 132
resetting, 81, 132, 135, 136, 141, 157
restoring data, 14, 48, 52, 82, 83, 84,

85, 86, 132, 133, 134, 136, 137,
157

restoring factory defaults, 3, 83, 85,
86, 133, 137

S 
screen. See display
serial connector, 51
SLIP protocol, 157
SMTP protocol, 157
soft keyboard, 30, 34, 110
software drivers
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about, 155
CompactFlash cards, 59, 95
infrared, 55
NIC, 58, 139
portable keyboard, 6

Software Product License Agreement,
149

sounds
about, 4
choosing, 30
hp volume profile, 4, 86
turning off, 79
volume profiles, 87

speaker. See sounds
Start menu, 25, 92
storage memory, 42, 43, 67, 80, 81,

94, 115
suspend, 79
switching programs. See programs
synchronizing

about, 5, 7, 48, 49, 97, 157
e-mail messages, 48, 69
Excel files, 48, 111
favorite links, 66
from a remote location, 50, 51
help for, 7
mobile favorites, 48, 66
Outlook, 48
schedule, 49, 67
starting, 49
status indicators, 28
troubleshooting, 139
Word files, 48, 110

T 
Tasks

about, 5, 97
adding notes to, 106
alarm for, 30
backing up, 3, 82, 83
categorizing, 106
changing, 107
creating, 106
customizing display of, 105

due date, 106
hot key, 19
start date, 106
Summary Screen, 107
synchronizing, 48
zooming, 142

technical support, 143
temperature, operating, 20
templates

Pocket Excel, 112
Pocket Word, 110

Today screen, 8, 28, 79, 89
to-do list. See Tasks
touch screen See also display, 157
Transcriber, 30, 35
transferring files, 51
troubleshooting

basic problems, 134
connections, 8
display, 141
infrared, 138
network connections, 139
remote connections, 138
USB cradle, 140

U-Z 
up/down control, 17
USB, 53, 54, 140, 157
USB cradle, 2, 14, 47, 51, 53, 54, 78,

155
videos, 7, 114
viewing images

at actual size, 126
in a slideshow, 126
in hp image viewer, 123

voice notes. See recording
volume. See sounds
warranty

software, 149
WAV files, 111
Welcome Wizard, 9, 13, 134
Windows Media Player, 5, 109, 114
WMA files, 5, 7
writing on the screen, 35

 

Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
h�p://myh66.com

h�p://usermanuals.us
h�p://www.somanuals.com

h�p://www.4manuals.cc
h�p://www.manual-lib.com
h�p://www.404manual.com
h�p://www.luxmanual.com

h�p://aubethermostatmanual.com
Golf course search by state

h�p://golfingnear.com
Email search by domain

h�p://emailbydomain.com
Auto manuals search

h�p://auto.somanuals.com
TV manuals search

h�p://tv.somanuals.com

http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

	1 Welcome
	What's in the Box
	Using This Manual
	hp Jornada Programs
	Where to Find Information

	2 Getting Started
	Hardware Features
	Using Your hp Jornada for the First Time
	Powering Your hp Jornada
	Turning Your hp Jornada On and Off
	Using the Hardware Buttons

	3 Overview of Microsoft Windows for Pocket PC
	Navigating in Microsoft Windows for Pocket PC
	Entering Information
	Finding and Organizing Information

	4 Connecting to Your Desktop PC
	Microsoft Activesync
	Connecting Your hp Jornada

	5 Connecting to the Internet or to a Network
	Connecting Your hp Jornada
	Creating an ISP or Network Connection
	Browsing the Web (or a Corporate Intranet)
	Sending and Receiving E-mail

	6 Configuring and Optimizing Your hp Jornada
	Managing Power
	Managing Memory
	Backing Up and Restoring Data
	Adjusting Settings
	Configuring Hardware Buttons
	Configuring Menus
	Adding or Removing Programs
	Accessories

	7 Microsoft Pocket Outlook
	Calendar
	Contacts
	Tasks
	Notes

	8 Companion Programs
	Microsoft Pocket Word
	Microsoft Pocket Excel
	Microsoft Windows Media Player
	Microsoft Reader
	MSN Messenger
	hp image viewer
	OmniSolve
	CodeWallet Pro

	9 Troubleshooting
	Resetting Your hp Jornada
	Basic Problems
	Remote Connections
	Display Problems

	10 Support and Service
	Web site
	Customer support
	Service
	Contacting Hewlett-Packard Worldwide

	Warranty
	Glossary
	Appendix: Character Recognition
	Index

